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Important Setup Information for SOAPware Practice Management

Before you begin

1. Contact GatewayEDI to begin Enrollment Process for submitting electronic claims.

2. Each Lesson should be completed in the order they are listed.

3. Current users of SOAPware that have already setup maintenance files should check each one 
for additional billing information required to complete the setup.

4. Lessons in this Chapter containing information used on the CMS 1500 form will have the block 
number from the CMS 1500 form shown in parentheses in the title.

5. If a section of Billing is inaccessible to a user, go to Security setup and check the Billing section 
for the User. Security is accessible by logging in to SOAPware as Administrator. 

Steps for setting up billing section of security can be found by clicking the link:  Billing Security 
Administration

http://www.gatewayedi.com/
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Getting Setup with Gateway EDI -- What to Expect

A brief description of the Provider Enrollment process.  

(Color coding is used to denote participant roles and associated activities.)
          Blue  = Office
         Teal = SOAPware
         Black = Gateway EDI (GEDI) 

1. Office purchases and installs SOAPware Clinical Suite and signs up for the following training 
sessions in exact order: 

          A.  SOAPware Billing Setup
          B.  Transaction Entry and Workflow
          C.  Claims Processing

2. Office contacts Gateway EDI (GEDI) and signs a contract with Gateway.  (Note:  This can 
happen before installing SOAPware CS.)

3. Office completes SOAPware master setup and begins practicing with the software in 
preparation for live use.  (Note:  This step can be done in conjunction with the steps shown 
below.)

4. GEDI will contact the Office to complete a Provider Enrollment online.  GEDI will request 
provider ID numbers and Master Insurance List (MIL) from Office; provider enrollment process will 
begin within two days of signed contract.

5.  GEDI will generate the Enrollment packet, and the Office is given payer enrollment packet to 
complete.

6. Office returns enrollment packet originals to GEDI and production date is estimated based 
upon projected payer approval time frames. 

Estimated average payer approval times, (by state), can be viewed on the attached 
spreadsheet.

The Office can begin sending commercial claims as each payer approval is granted, followed 
by governmental approvals.)

7. GEDI verifies accuracy and forwards payer enrollment agreements to Carriers. 

8. GEDI contacts Carriers to obtain approval dates and records dates on addendum. 
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9. BCBS, Medicare, and Medicaid payer approvals are obtained.  The training packet, which 
includes a copy of the Providers Addendum (list of Provider ID numbers and payer approvals), 
training CD, and MIL is sent to the Office. 

10. GEDI will contact the Office to schedule an "install appointment."  

IMPORTANT:  BEFORE scheduling install appointment with GEDI, the Office MUST have 
attended and completed the training sessions listed in #1 above AND have completed setup of 
SOAPware system.

HIGHLY RECOMMENDED:  When the Office is ready to send the first live claim file, (with real patient 
claims), SOAPware recommends that the office use a one-on-one training session to provide 
assistance from SOAPware PM experts for this first filing.  A SOAPware representative will inspect 
the setup of the system to ensure everything looks correct, and will also assist the Office with 
creating, scrubbing and troubleshooting the first claim file.  SOAPware will also help the office 
prepare for their setup call with GEDI.

11.  Office sends first file with live claims to GEDI; file is tested (two day turnaround) before GEDI 
production begins. 

12.  Once the Office is installed and is sending claims, the Office will be contacted to schedule 
initial report training. 

13. Report training is completed. 

14.  Two weeks after production begins, a second report/web training is offered to the Office. 

15.  Two week-stage web training is completed. 

16.  Each office is assigned to a GEDI New Accounts Rep who will monitor their claims for first 
30-60 day period in production to ensure that the claims acceptance rate is above 85%. 

17.  Office may request additional phone training with GEDI and/or call/email with Support 
questions at any time. 

18.  GEDI Customer Service will work with the Office to correct any errors on claims submitted. 
GEDI will always be available for any insurance questions, or other questions about the reports or 
errors.  Anything related to the generation of claims files or errors on the software side will be 
handled by SOAPware Tech Support via www.soapware.com/ticket

NOTE: For an estimate on the average amount of time it will take to get approvals with the payers 
in your state, please see the attached Excel spreadsheet. 
PLEASE NOTE THAT THIS TIME ESTIMATE BEGINS AFTER GATEWAY HAS RECEIVED YOUR 

http://www.soapware.com/ticket/
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PLEASE NOTE THAT THIS TIME ESTIMATE BEGINS AFTER GATEWAY HAS RECEIVED YOUR 
COMPLETED PROVIDER ENROLLMENT PAPERWORK.  
To help expedite the setup process, Office should submit completed GEDI enrollment forms as 
soon as possible.
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1. Manage Facilities (Block 24B and Block 32)

Tools -> Manage Facilities

Facility Manager

Click the Create New Facility button. 
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Setup Facility Details

Steps 1-5 identifies the Place of Service-Block 32 

1. The commonly known Facility Name. 
2. Legal Name of the facility. (block 32)
3. Physical address of the facility. (block 32)
4. City, State and Zip of the facility. You must include 9 digit Zip Code  (Block 32)
5. Clinic Phone number.
6. NPI number assigned to the facility. (Block 32a)
7. Place of Service this selection specifies the code that is placed on claims (Block 24B) 
identifying the type of facility. 
8. Phone number for Billing Inquiries. This number will appear on Patient Statements, Receipts, 
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etc. for billing questions
9. Clinic CLIA number
10. State License Number
11.  Press Update to save 

Home visits

When filing electronic claims for home visits, the new 5010 format requires the patient's address 
as the Place of service. If you set up a facility name Home and select Place of Service Home-12, 
and leave everything else blank, Gateway EDI will plug the patient's address into the file when 
they see that Place of Service code 12.

1. Type Home or any name for the Facility. (This name will be listed in the drop down options for 
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facility selection)
2. Select Home-12 from the drop down list of POS codes.
3. Click Update.

Facility Scheduler Tab

This is the location for the functional details of facilities in the Scheduler. Three main sections 
here: Provider/Resource Management, Business Hours Management, and Facility Closings.

Provider/Resource Management

In this area, should be a list of licensed providers for the site. If a provider is not already in this list, 
the provider likely does not have a license to the Scheduler. This area is the location to actually 
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activate the providers/resources that will be using the Facility.

Business Hours Management

This section allows the working hours for the Provider/Resource to be set for the facility. If the user 
has multiple facilities, among which a Providers/Resource travel, set the days and hours that 
each will be working at each facility each week. These times that are set up will then be available 
for scheduling for each Provider/Resource.

Facility Closings

Block off the days the clinic will not be open to see patients, or is closed entirely for holidays, etc. 
Notice this section applies to the overall facility regardless of the provider. To set up a new 
closing, Click the Add Closing button (with the green plus sign).
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Facility Additional IDs Tab

Add ID numbers for Service Facility if Insurance company requires these in addition to Facility NPI. 

Note: Leave blank unless specific payers require this information.

1. Click on Additional IDs tab.
2. Click Add icon (green plus) and select the insurance company from the list (Tools->Insurance 
Companies)
3. Enter additional ID numbers.
4. Click Okay.

 Repeat for additional Payers only if required.
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5. Click to edit information.
6. Update
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2. Manage Groups/Billing Provider/ Pay To Information (Block 33)

Tools menu -> Manage Groups

Manage Groups/Pay To Information 

Click Add Group button to add a new Group/Pay to information. 
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Add a Group

Enter Pay To/Billing Provider information for the Clinic.  Creating a Group and associating a 
provider with a Group, will cause the group information to default as the Provider's Pay To/Billing 
Provider information, with each insurance company. If there a specific Insurance Company that 
recognizes a different Pay To (or Group) for a particular Provider, the Group information can be 
overridden in the Insurance Company dialog, as needed.

It is highly recommended that you set up your Groups after your Facilities, as it will greatly 
streamline your setup of insurance companies later in the setup process. Note: It is 
recommended that even if a Provider in the clinic is his/her own group, you can setup a single 
provider as a group. The Group information will be the default Pay To Provider for the Provider. All 
in all, a group can represent a single doctor or a group of doctors. It is really just who the billing 
entity is for the Provider.  
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1. Contact Information: Enter the basic demographic information for the group. (Name, Address 
and Phone) Include 9 digit Zip Code.  Note: Address must be a street address. If Pay-To address 
is a PO Box, etc., that information will be entered in section 5

2. Select Person or Non Person Entity type

3. ID Numbers: Enter the appropriate ID for the group. 
Indicate either the EIN or social security number and add the number. 
Enter Billing NPI number. 

4. Electronic:  Select Mutually Defined - ZZ for the identifier for the Submitter ID. This ID is how 
Gateway EDI identifies who is submitting the claim file. The ID field will be your 4 digit Site ID 
code provided to you by Gateway EDI.
Enter Billing UPIN
Enter Billing State License

5. Pay-To Address: If payment is sent to an address other than the street address in Contact 
Information, enter that address here. Include 9 digit Zip Code.

6. Paper Claims Legacy ID: (Optional) Select from the drop down to indicate a particular 
ID/number, if your state requires a particular ID on every claim. For instance, if your state requires 
the Taxonomy Code, you can enter the taxonomy identifier and code, and the information will go in 
the legacy field of every claim, along with the NPI number. If you are not aware that a particular ID 
is required for every claim for your state and payer base, other than the NPI, you may be able to 
ignore this field. 

 

7. Additional IDs: When setting up a brand new system, you can ignore the Insurance Information 
section, initially. You will have to have your insurance companies setup first, before you can really 
take advantage of this field. Once you have finished the setup process, and need to add additional 
IDs required for a particular insurance company, you can change that information here at the 
group level, if needed. 
      - To create an additional ID for a specific insurance company (for your group), you will click the 
Create New button (with the green + sign). Search for the needed Insurance Company. Click 
Select. 

Electronic Claims: Add the additional ID required by the selected insurance company. If UPIN or 
State License is required, you can click on the '+' to automatically add the ID from step 2.

Paper Claims: If a legacy ID is required in addition to referring provider NPI for paper claims,  use 
the drop down to select the legacy ID Qualifier  followed by the number and then Click Save.
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8. Click Save when done.

Newly added Group/Pay to Provider is added to the List. Most often there will only be a single 
Provider or a single group listed here per clinic. A Group can contain one to many Providers, but a 
Provider can only be associated with one group. 
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3. Provider Manager (Blocks 24J and 31)

Tools -> Provider Manager

Enter/edit Rendering Provider information, Link Provider to a Group. The Misc. tab will indicate 
to Payers that the Selected Group is the Billing/Pay To Provider

1. Click to highlight and Select a Provider from the list. Providers should have been added when 
SOAPware was initially installed and licenses were activated. 

2. Enter the Provider's demographic information, including his/her DEA, NPI and Taxonomy 
numbers. 
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3. Click the Misc Tab to assign the Provider to a specific Group.

4. Group: Click the drop down arrow to display a list of available Groups. Select the appropriate 
Group to associate to the Provider. 
5. Superbill Task User*: The user selected in this dropdown box will be the default user assigned 
tasks from the selected physician when superbills are posted. 
6. Checking this checkbox will allow a task to be autocreated and automatically assigned (to the 
user selected in step 5 above) every time a superbill is posted, without requiring the physician to 
manually click to add the task each time.
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*Until a specific user is selected in this dropdown box, the physician will be listed as the default 
user for the task created when a superbill is posted.  If a group of staff members within the clinic 
process superbills, post charges and create claims for each provider, and there is not one 
designated person who does this for a specific provider, a generic user can be set up under 
Security to which to assign these tasks. Staff members needing to see the newly posted 
superbills can then simply pull up the task list for the generic user created.

Signature Tab (Block 31)

The clinician's signature will need to be captured via a signature capture device, scanning in a 
hand written signature as a picture, or even using Microsoft Paint. Save the signature in a picture 
format.

1. Click the Signature tab to insert a signature for the Provider
2. Click the Select Image button to capture the image. Find the location of the stored signature 
image and Click on the image. Click Open.
3. The signature will appear within the box provided to preview. If the image needs to be 
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increased in size, click the + button to zoom in. If the image needs to be made smaller, click the - 
sign to zoom out. When first displayed, the image will default to 100% of its actual size.
4. Click Update to save signature.
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4. Setting Default Claim Options/Base Export Path

Setup how paper and electronic claims are exported from the system.

Tools -> Billing Maintenance -> Claims Options

Paper Claim Options

1. Default Printer: Select from the drop down to set the default printer when printing paper claims.  

2. Print Full CMS Form: If not using preprinted CMS 1500 forms, check Print Full CMS form to print 
the entire claim form, including the red lines (must have color printer).

3. If using preprinted CMS 1500 forms, leave blank. Only text will print.

Please Note:
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Most printer manufacturers install a PCL (Printer Command Language) driver by default. This 
works well if printing documents in just plain text and with very little formatting, for example a word 
document on a home computer. However with the complexity of forms and page layouts, it is 
recommend, printing these documents on a PS (Post Script) Print Driver instead of a PCL driver. 
This type of printer driver will handle the forms information most efficiently. SOAPware 
recommends using any business grade printer, or a color laser jet printer, if selecting Print Full 
CMS Form.

Note: Selecting Print Full CMS Form will print the front of the CMS 1500 only, and will not include 
the print on the back of the form. If a payer requires the standard front and back of the CMS 1500 
form, the claim will not be acceptable.

SOAPware does not support printers/scanners. Meaning that SOAPware does not install printer 
drivers or set printer configurations. Please contact an IT person for additional hardware matters. 
However, it is recommend to download the most recent printer drivers needed from the 
manufacturer's website. It is usually a FREE DOWNLOAD. If there is trouble locating the driver 
needed, please contact the manufacturer directly. Be cautious of downloading drives from an 
alternate source other than the printer manufacturer. 

Thank you,
SOAPware Support
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Electronic Claim Options

1.  Office Contact: Enter the Contact Name for the person in the office who will be the contact for 
Gateway EDI, if any issues arise.

2.  Office Contact Phone: Enter the Contact Phone Number for the person in the office who will be 
the Gateway EDI contact.

3. Office Contact Fax:  Enter the Contact Fax Number for the person in the office who will be the 
Gateway EDI contact.

4. Office Contact Email:  Enter the Contact email address for the person in the office who will be 
the Gateway EDI contact.

5.  Output Path: Specify a file location to which claims will be exported. Note: Make sure that the 
Save Local Copy box is checked to save your claim files to a local file. If more than one person in 
the office works with claims, it is recommended that this file path be stored in a shared file/drive to 
allow multiple people to access the claim files.
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6.  Auto Submit: If this box is checked, electronic claim files will be automatically uploaded to the 
clinic Gateway EDI site. You will have to have the correct information entered in the Clearinghouse 
fields in the section below to ensure this will work correctly. If you would like to manually save and 
upload claim files to Gateway EDI, uncheck this box.

7. Save Local Copy: Check this box if you would like to store a copy of your claim files on a local 
drive/file location. If you have Auto Submit and Save Local Copy checked, you will be able to both 
auto submit your files to Gateway EDI, and you will have the claim file stored in a local drive, in 
case any discrepancy comes up, and the file needs to be re-uploaded.

1. Name: Indicates the name of the Clearinghouse.

2. Clearinghouse ID: If using Gateway EDI as your clearinghouse, enter the following number in 
this field: 431420764 

3. Receiver Qualifier: If using Gateway EDI as your clearinghouse, select Mutually Defined - ZZ 
from the drop down list.
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4. Receiver ID: If using Gateway EDI as your clearinghouse, enter the following number: 
431420764000000 

5. User Name: Enter the 4 digit site ID assigned to your clinic by Gateway EDI.

6. Password: This password will be given to you by Gateway EDI. This will be the needed 
password to auto submit your claim files using their sftp site.

7. Server: If using Gateway EDI as your clearinghouse, enter the following: sftp.gatewayedi.com

8. Testing: Only check this box if you are wanting to send a test file to Gateway EDI. IMPORTANT: 
For your first claim submission to Gateway EDI, do not check this box. Gateway prefers to have 
live claims sent to them. They will manually review the file first, and if everything looks good, they 
will forward on to payers.

9. Accept Assignment: Check this box if you would like to default to Accept Assignment on all 
claims. It can be overridden at the claim level, if needed.

10. Click Okay to save.
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5. PM Security Administration 

Tools -> Security

Billing Security options have been added for Groups, Roles and Users. Each section will have to 
be completed to allow Users access to assigned areas of Billing. Click on a specified action to 
allow access (green check mark), deny access (red X) or default to the user's individual 
privileges (leave blank ). Clicking on Allow All button will place a check in all boxes and Clicking 
Deny All will place a red X in all boxes. 

Users should be added to Security Prior to assigning privileges to Billing

Security changes made will not take effect until you log out. For additional documentation on 
Security see  online manual
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Assign Billing Security Privileges to Roles

Access to specified sections can be manually allowed or denied for each user.

Another way to assign security privileges to users is to select or create a Role, assign 
accessibility to the role, and then assign that Role to a User. This will eliminate the need to go into 
every section of billing for each user and repeat the process. 

1. Click on the expander node next to Roles.

2. Click on the expander node next to one of the Roles in the list. (Screenshot shows Office 
Manager selected)
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Billing Access

3. Click the expander node next to Billing 

4. Click on Billing

5. Click inside the box next to Accessible-This will allow any user assigned the Role of Office 
Manager to access the Billing Menu option
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Adjustment Maintenance 

6. Click the expander node next to Billing Maintenance

7. Double Click Adjustment Maintenance

8.  Click on a specified action to allow access (green check mark), deny access (red X) or default 
to the user's individual privileges (leave blank ). Clicking on Allow All button will place a check in 
all boxes and Clicking on Deny All will place a red X in all boxes. 

Add code-Allows user to add new adjustment codes in Adjustment Maintenance dialog
Edit code-Allows user to edit adjustment codes 
Inactivate code-Allows user to mark an adjustment code Inactive. 

Repeat Steps 7 and 8 for each section/action under Billing 
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Claims Options

Accept Assignment-Deny access or allow user to Accept Assignment on claims
Auto Submit-Deny access or allow user to Auto Submit claims
Clearinghouse ID-Deny access or allow user to edit Clearinghouse ID
Clearinghouse Name-Deny access or allow user to edit Clearinghouse name
Default Printer-Deny access or allow user to set default printer for claims
Office Contact-Deny access or allow user to edit Office Contact
Office Contact Phone-Deny access or allow user to edit Office Contact Phone
Office Contact Fax-Deny access or allow user to edit Office Contact Fax
Office Contact Email-Deny access or allow user to edit Office Contact Email
Output Path-Deny access or allow user to change output path 
Password-Deny access or allow user to edit password
Print Full CMS Form-Deny access or allow user to select to print Full CMS Form
Receiver ID-Deny access or allow user to edit Receiver ID
Receiver Qualifier-Deny access or allow user to edit Receiver Qualifier
Save Local Copy-Deny access or allow user to Save Local Copy of claim files
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Server-Deny access or allow user to edit Receiver Server
Testing-Deny access or allow user to change claim file to Test file
User Name-Deny access or allow user to edit User Name

CPT Maintenance

Edit code-Deny access or allow user to Edit CPT Maintenance 
Inactivate code-Deny access or allow user to mark a CPT code Inactive
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Custom Charges Maintenance

Add code-Deny access or allow user to add a Custom Charge code
Edit code-Deny access or allow user to edit a Custom Charge code
Inactivate code-Deny access or allow user to mark a Custom charge Inactive

Fee Schedule Maintenance

Accessible-Deny access or allow user access to the Fee Schedule menu option 
Add Fee Schedule-Deny access or allow user ability to Add a new Fee Schedule
Edit Fee Schedule-Deny access or allow user ability to make edits within the Fee Schedules
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Inactivate Fee Schedule-Deny access or allow user the ability to make a Fee Schedule Inactive
Add Code-Deny access or allow user the ability to Add a new Code from the HCPCS/CPT list to a 
Fee Schedule
Update Code Values -Deny access or allow user to Update Code amounts 

HCPCS Maintenance

Edit code-Deny access or allow user to edit a HCPCS code in Maintenance
Inactivate code-Deny access or allow user to change a HCPCS code to Inactive
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ICD Maintenance

Edit code-Deny access or allow user to edit a Diagnosis code in ICD Maintenance
Inactivate code-Deny access or allow user to change a Diagnosis code to Inactive

Claim Details

Edit Owner-Deny access or allow user to change Owner/Provider in Charge Details
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Insurance Company Manager

Accessible-Allow/Deny user access to the Insurance Company Master files/Maintenance
Add Insurance Company-Allow/Deny user to add new insurance companies
Update Insurance Company-Allow/Deny user to update/save insurance companies
Remove Insurance Company-Allow/Deny user to delete/remove an insurance company from 
Insurance company Maintenance

Claims Manager

Accessible-Deny access or allow user access to the Claims Manager
Scrub Claim-Deny access or allow user to scrub claims in the Claims Manager
Edit Claim-Deny access or allow user to edit claims in the Claims Manager
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Change Claim Status-Deny access or allow user to change the claim status in the Claims 
Manager
Rebuild Claim-Deny access or allow user to Rebuild a claim in the Claims Manager
Generate Electronic-Deny access or allow user to generate an electronic claims file in the 
Claims Manager
Submit Claims-Deny access or allow user to submit claims in the Claims Manager
Print Claims-Deny access or allow user to print claim forms in the Claims Manager

Insurance Payment

Accessible-Deny access or allow user access to Insurance Payment Posting
Create Payment-Deny access or allow user to Create a new Insurance Payment
Save Claim-Deny access or allow user to apply a payment and save that payment in Insurance 
Payment Posting
Post Payment-Deny access or allow user to post a payment in Insurance Payment Posting
Apply Payment Details-Deny access or allow user access to add/edit Payment/Remit details in 
Insurance Payment dialog
Print Payment-Deny access or allow user access to Print Payment in Insurance Payment dialog
Change Next Action-Deny access or allow user to edit the Next Action option in Insurance 
Payment dialog
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Patient Account

Create New Chart/Patient Account-Deny access or allow user to create a new chart or patient 
account
Allow Check Self Pay-Deny access or allow user to check the box next to self pay option on 
patient account information bar
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Patient Claims

Add On Hold/Claim Notes-Deny access or allow user access to comment in the On Hold notes 
section or the Claims Notes section in the Claims Tab
Delete Claim-Deny access or allow user to remove/delete claims in the Claims Tab
Edit Charge-Deny access or allow user to edit charges in the Claims Tab
Edit More Info-Deny access or allow user to edit More Info dialog in the Claims Tab
Select CMS1500-Deny access or allow user to select/view the CMS 1500 claim form from the 
Claims Tab
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Patient Family

Add Dependent-Deny access or allow user to add a dependent to a Patient Account Family tab
Make Payment-Deny access or allow user to make a payment in the Patient Account Family tab
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Patient Ledger

Add Charge-Deny access or allow user to add a charge from Patient Ledger
Edit Charge-Deny access or allow user to edit a charge from Patient Ledger
Delete Charge-Deny access or allow user to delete a charge from Patient Ledger
Add Adjustment-Deny access or allow user to apply an adjustment from Patient Ledger
Edit Adjustment-Deny access or allow user to edit an adjustment from Patient Ledger
Delete Adjustment-Deny access or allow user to delete an adjustment from Patient Ledger
Add Payment-Deny access or allow user to add a payment from Patient Ledger
Edit Payment-Deny access or allow user to edit a payment from Patient Ledger
Delete Payment-Deny access or allow user to delete a payment from Patient Ledger
Print Receipt-Deny access or allow user to print a receipt from Patient Ledger
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Patient New Charges

Create Visit-�user to create a new visit in New Charges tab
Delete Visit-Deny access or allow user to delete a visit in New Charges tab
Add Adjustment-Deny access or allow user to add an adjustment to a charge in New Charges tab
Delete Adjustment-Deny access or allow user to delete an adjustment in New Charges tab
Add Payment-Deny access or allow user to add a payment to a charge in New Charges tab
Delete Payment-Deny access or allow user to delete a payment in New Charges tab
Add Charge-Deny access or allow user to add a charge to a visit in New Charges tab
Delete Charge-Deny access or allow user to delete a charge in New Charges tab
Edit Charge Details-Deny access or allow user to edit charge details �
Add More Info-Deny access or allow user access to the More Info dialog in New Charges tab
Mark as Incomplete-Deny access or allow user to mark a charge as Incomplete in New Charges 
tab
Change Follow-Up Action-Deny access or allow user to change the Follow Up action in New 
Charges tab
Enter Claim Comments-Deny access or allow user to enter claim comments to a charge in New 
Charges tab
Apply Co-Pay-Deny access or allow user to apply a Co-Pay to a charge in New Charges tab
Apply Pre-Pay-Deny access or allow user to Apply a Pre-Pay to a charge in New Charges tab
Omit from Statement -Deny access or allow user to omit a charge from a claim in New Charges 
tab
Post a Visit-Deny access or allow user to Post a Visit to the Ledger from the New Charges tab
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Patient Schedule

Select a Scheduplate-Deny access or allow user access to scheduplates in Schedule tab
Add a Referral-Deny access or allow user to add a referral to an appointment in Schedule tab
Change the Status-Deny access or allow user to change an appointment status in Schedule tab
Set a Recurrence-Deny access or allow user to set a recurring appointment for a patient in 
Schedule tab
Add a Resource-Deny access or allow user to add a Resource in Schedule tab
Delete an Appointment-Deny access or allow user to delete a scheduled appointment in 
Schedule tab
Edit Resource-Deny access or allow user to edit a resource in Schedule tab
Enter Visit Comments-Deny access or allow user to enter visit comments in Schedule tab
Check Insurance Verification-Deny access or allow user to check Insurance Verified in Schedule 
tab
Check in a Patient-Deny access or allow user to check in a patient in Schedule tab
Take a Co-Pay-Deny access or allow user to take a co-pay in Schedule tab
Create a New Visit-Deny access or allow user to create a new visit in Schedule tab
Print a Visit-Deny access or allow user to print a visit in Schedule tab
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Patient Statements

Open Statements-Deny access or allow user access to the Statements tab in Patient Account

Payer Account

Edit Demographics-Deny access or allow user to edit demographics in Payer/Non-Patient Account
Add Dependent-Deny access or allow user to add a dependent to a Payer/Non-Patient Account
Delete Dependent-Deny access or allow user to delete a dependent in a Payer/Non-Patient 



Practice Management 2012 User Manual  - 52

Account

Reports

CPT Master-Deny or allow user access to view/print the following reports from Billing -> Reports 
menu 
HCPCS Master
ICD Master
Custom Charge Master
Adjustment Master
Fee Schedule Report
Dependency Report
Duplicate Report
Payment Summary
Production By Procedure
Daily Receivable Summary
Statement Report
Outstanding Insurance 
Credit Balance Report
SOAPnote Audit Report
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6. CPT® Code Maintenance (Block 24D)

Located in the Tools menu -> Billing Maintenance ->CPT Maintenance

CPT®  Code Maintenance  

Maintain CPT codes. Assign NDC codes, CLIA numbers to CPT codes.
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CPT®  Search by Code 

Begin typing the CPT code in the CPT Look up and as you type, the codes and short descriptions 
are listed.

CPT® Search by Description

Begin typing the CPT description in the Short Description Look up and as you type, the codes and 
short descriptions are listed.
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Create a Custom CPT®  Description

1. After selecting a CPT code, Place a check mark if you wish to use the custom descriptions 
when searching for this code.

2. Begin typing a short description of your choice for this selected CPT code.

Note:  Only complete this section if using descriptions other than the original short descriptions 
for the CPT code.

Inactivate a CPT®  code

To inactivate a CPT Code, place a check mark in the Inactive box. This will not completely remove 
it from the data base, but will remove it from the list. See Hide/Show Inactive CPT Codes.
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Hide/Show Inactive CPT®  Codes

If a code had been Inactivated and is no longer going to be used, it can be hidden when viewing 
the Code List by placing a check mark in the Hide Inactive Codes box.

View All CPT®  Descriptions

To view all descriptions associated with CPT codes in the Code List, Click the radio button next to 
Full View. Included in the list will be any Custom Short, Medium or Long  descriptions if the Use 
Custom Descriptions is selected when Creating a Custom CPT Description .

CPT®  Effective, Modified or Deactivation Date

1. Effective date column lists the year the code is in effect.

2. Modified Date column lists the date the code was last modified.
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3. When a CPT code is discontinued Deactivation Date column will list the date it was 
discontinued
Note: The dates are automatically inserted. 
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7. HCPCS Maintenance (Block 24D)

Tools -> Billing Maintenance -> HCPCS Maintenance

HCPCS Maintenance

Maintain HCPCS codes. Assign NDC number to specific codes to automatically populate when 
the code is charged. 
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HCPCS Search by Code

Begin typing the HCPCS code in the HCPCS Look up and as you type, the codes and short 
descriptions are listed.

HCPCS Search by Description

Begin typing the HCPCS description in the HCPCS Short Description Look up, and as you type, 
the codes and short descriptions are listed.

Create a Custom HCPCS Description

1. After selecting a HCPCS code, Place a check mark if you wish to Use the Custom Descriptions 
when searching for this code.
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2. Begin typing a short description of your choice for this selected HCPCS code.

Note:  Only complete this section if using descriptions other than the original short descriptions 
for the HCPCS code. 

Inactivate a HCPCS code

To inactivate a HCPCS and delete it from the HCPCS Code List, Place a check mark in the 
Inactive box. This will not completely remove it from the data base, but will hide it from view if there 
is also a check mark in the Hide Inactive Codes option.
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Assign NDC Number to specific HCPCS

1. If a HCPCS requires NDC numbers, type the numbers into the NDC Number field.
2. Determine which codes have NDC numbers assigned to them at a glance. If there is a number 
in the NDC column, that number will be included on paper and electronic claims whenever that 
code is charged in a patient account.
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View all HCPCS Descriptions

To view all descriptions associated with the HCPCS codes in the Code list, Click the radio button 
next to Full View.  Included in the list will be any Custom descriptions that have been assigned to 
HCPCS codes.

HCPCS Add, Effective and Inactive Date

1. Add Date column lists the date the code is added to the data base.

2. Effective Date lists the date the code is in effect.
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3. Inactive Date lists the date a code is discontinued or deleted. 

Hide/Show Inactive HCPCS Codes

If a code had been Inactivated and is no longer going to be used it can be removed from the Code 
List by placing a check mark in the Hide Inactive Codes box.
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8. ICD Maintenance (Block 21)

 Tools menu -> Billing Maintenance -> ICD Maintenance

ICD Maintenance

ICD Search by code

Begin typing the ICD code in the ICD Look up and as you type, the codes and short descriptions 
are
listed.
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ICD Search by description

Begin typing the ICD description in the Short Description lockup and as you type, the codes and 
short
descriptions are listed.

Create a Custom ICD Description

1. After selecting a ICD code, Place a check mark if you wish to use the custom descriptions when
searching for this code.

2. Begin typing a short description of your choice for this selected ICD code.

3. Click Save.

Note: Only complete this section if using descriptions other than the original short descriptions for 
the
ICD code.
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Inactivate an ICD code

1. To inactivate a ICD code and delete it from the ICD Code List, Place a check mark in the 
Inactive box.

2. Click Save. 

Note: This will not completely remove it from the data base, but will hide it from view if there is 
also a check mark in
the Hide Inactive Codes option.

ICD Effective, Modified and Deactivation Date

1. Effective date column lists the year the code is in effect.

2. Modified Date column lists the date the code was last modified.

3. When an ICD code is discontinued Deactivation Date column will list the date it was 
discontinued.

Note: The dates are automatically inserted when modified or updated
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Hide/Show Inactive ICD Codes

If a code had been Inactivated and is no longer going to be used it can be removed from the Code 
List
by placing a check mark in the Hide Inactive Codes box.
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9. Adjustment Maintenance

Tools menu -> Billing Maintenance -> Adjustment Maintenance

Adjustment Maintenance

Add an Adjustment

1. Click on the Green + to open the New Code Section.
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2. Type Numeric and/or Alpha Code.

3. Give the new Code a Description.

4. Click the Add button. The new Custom Adjustment code is now added to the Code List.

Inactivate an Adjustment

To inactivate an Adjustment Code and delete it from the Code List, Place a check mark in the 
Inactive box. This
will not completely remove it from the data base, but will hide it from view if there is also a check 
mark in
the Hide Inactive Codes option.

Adjustment Search by Code

Begin typing the Custom Adjustment code in the Code Search and as you type, the codes and 
short descriptions are
listed.
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Adjustment Search by Description

Begin typing the Adjustment description in the Short Description Search and as you type, the 
codes and short
descriptions are listed.

Adjustment Effective, Modified or Deactivation Date

1. Effective date column lists the year the code is in effect.

2. Modified Date column lists the date the code was last modified.

3. When an Adjustment code is discontinued Deactivation Date column will list the date it was 
discontinued.

Note: The dates are automatically inserted when modified or updated
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Hide/Show Inactive Adjustment Codes

If a code had been Inactivated and is no longer going to be used it can be removed from the Code 
List
by placing a check mark in the Hide Inactive Codes box.
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10. Custom Charges Maintenance

Tools menu -> Billing Maintenance -> Custom Charges Maintenance

Custom Charges Maintenance

Add a Custom Charge

1. Click the Green + to open the New Code dialog.
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1. Type new Code using numeric and/or alpha characters.

2. Type a Short Description for the code.

3. Type a Medium Description. (optional) 

4. Type a Long Description. (optional) 

5. Place a check mark in the box if item or service is taxable.

6. Click Add. New Custom Charge is now added to the Custom Charges List. 

Inactivate a Custom Charge

1. To inactivate a Custom Code and delete it from the Code List, Place a check mark in the 
Inactive box. 

2. Click Save.

Note: This will not completely remove it from the data base, but will hide it from view if there is 
also a check mark in
the Hide Inactive Codes option.

Custom Charge Search by Code

Begin typing the Custom Charge code in the Code Search and as you type, the codes and short 
descriptions are
listed.
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Custom Charge Search by Description

Begin typing the Custom Charge description in the Short Description Search and as you type, the 
codes and short
descriptions are listed.

Custom Charge Effective, Modified and Deactivation Date

1. Effective date column lists the year the code is in effect.

2. Modified Date column lists the date the code was last modified.

3. When a Custom Charge code is discontinued Deactivation Date column will list the date it was 
discontinued.

Note: The dates are automatically inserted when the code is modified or updated.

Hide/Show inactive Custom Charges

If a code had been Inactivated and is no longer going to be used it can be removed from the Code 
List
by placing a check mark in the Hide Inactive Codes box.
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11. Fee Schedule Maintenance (Block 24F)

Tools menu -> Billing Maintenance -> Fee Schedule Maintenance

Fee Schedule Maintenance

This screen shot shows the Maintenance screen after building 4 different Fee Schedules. The 
Default Fee Schedule amounts will have to be manually entered, and other Fee Schedules can be 
based on those fees. Aetna and BCBS AR are based on 100% of the existing Default fee 
schedule. Medicare is Based on 99% of the Default Fee Schedule for this example.

Adding Codes to a Fee Schedule

Begin by adding Procedure and HCPCS codes to the Default Fee schedule. 

1. Click on the Drop Down Arrow in the Name field to open the Name(s) of existing fee schedules.
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2. Double Click on Default in the Drop Down list.

3. Click the Add Code button to open the Code Search dialog.

4. Begin typing the code and as you type, a list of codes and the Description of the codes will 
display.
5. When the correct CPT/HCPCS is in the Code and Description search field, Click the Okay 
button.
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6. Click the Add Code button and repeat steps 4-5 until Code list is complete with Procedure 
codes and HCPCS codes most commonly used in your practice

Create a Fee Schedule by Manual Entry

Use the newly created list of codes to add a charge for each code in the Default Fee Schedule. 
Make sure the Manual Entry option is selected

1. With Default Fee Schedule still selected, Click the Update Codes button in the Fee Schedule 
Details to open the Default Codes Update dialog.
2. Begin typing the code.
3. Type a charge amount for the code. The Default Amount field will automatically populate when 
applied.
4. Click the Apply button. 
5. Repeat steps 2-4 until all codes have a fee applied and Click the Close button.
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Note: Codes will have to be added to the Code List before they can be found in the Codes Update 
dialog list.  

Create a Fee Schedule Based on an Existing Schedule

A Fee Schedule can be automatically priced based on a percentage of any of the existing fee 
schedules.
1. Add a new fee schedule and Type a name for the schedule.
2. Click Based On Existing.
3. Select Default from the Drop down list and Type a percentage of the Default fee schedule 
amount to base the new fee schedule charge.
4. Click the Add button. 

5. Scroll over to the column to verify the new Fee Schedule has been added to the Code List.
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Update fees for codes added using the Manual Entry Option

Update all Fee Schedules that have been added using the Manual Entry option. If a Fee Schedule 
has been added using the Based on Existing option, those steps will follow.

1. With Default Fee Schedule selected, Click the Update Codes button in the Fee Schedule 
Details to open the Default Codes Update dialog.
2. Begin typing the code.
3. Type the updated fee for the code. The Default Amount field will automatically update when 
Applied and Closed.
4. Click the Apply button. 
5. Repeat steps 2-4 until all codes have been updated, and then Click the Close button.
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Update codes with fees Based on Existing Fee Schedules

Prior to updating fees that have been added using Based on Existing Fee Schedule option, the 
Based On Fee Schedule will have to be updated by following steps in the Update fees for codes 
added using the Manual Entry Option section of this manual.
1. Scroll to find the fee schedule to update and then Click anywhere inside the column. In this 
example Cigna is the fee schedule selected.
2. With the Fee Schedule in the Name field of the Details section, Click on the Preview button. The 
fees will change according to the percentage amount.
3. Click on Save.

Searching for a fee by code  

Search all Fee Schedules for fees applied to codes by code number.
1. Click inside the Code Search field in the Code list section and begin typing the Code. The code 
is highlighted for each fee schedule displaying the fee.
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Hide Inactive Fee Schedule(s)

If a Fee Schedule has been Inactivated and is no longer going to be used it can be removed from 
the Fee Schedule List
by placing a check mark in the Hide Inactive Items box.

Inactivating a Fee Schedule

1. To inactivate a Fee Schedule and delete it from the Fee Schedule List, Place a check mark in 
the Inactive box.
2. Click Save.
Note: This will not completely remove it from the data base, but will hide it from view if there is 
also a
check mark in the Hide Inactive Codes option.
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12. Insurance Company Manager

Tools -> Insurance Companies

Insurance Company Maintenance

 
Add new Insurance Companies, Edit existing Insurance Companies and Associate Providers to 
Insurance Companies when submitting Insurance Claims. 

1. Add a new Insurance Company. 
2. Edit an existing Insurance Company.
3. Delete an Insurance Company.
4. Click inside the blank grid directly below column headers and begin typing to search by name, 
City, State, etc.
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Add a New Insurance Company

1. Click Add New Company icon to open Edit Insurance Company dialog.
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2. Insurance Company Information: Add Insurance Company Name, mailing address, phone 
and fax (optional)
NPI: National Plan Identifier/Pay-To Plan secondary Identification (Not Implemented. Leave blank)
Type: This will be used to determine which box to check in Block 1. on the CMS 1500 form.
Eligibility ID Qualifier: This will identify the type of Receiver ID used for checking insurance 
eligibility for patients. Add Eligibility ID in each provider's billing information (See Step 6) For 
payers requiring a Legacy ID , select ‘Prior Identifier Number - Q4’ For payers requiring a Tax ID , 
select ‘Federal Taxpayer Identification Number-TJ’.  If the tax ID option is selected, the Receiver ID 
field is automatically populated from the Group/Billing tax ID setup in Manage Groups. There are 
several other options in the drop down but they’re currently not used. If not required by the payer, 
leave blank.
Group Provider (Legacy)-  This is for information purposes only, any Legacy Fee Schedules 
previously assigned to this Payer from earlier versions of SOAPware.
Fee Schedule (Legacy)- This is for information purposes only, any Legacy Fee Schedules 
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previously assigned to this Payer from earlier versions of SOAPware.
Fee Schedule- Use the Drop Down option to select a Fee Schedule from the list in Fee Schedule 
Maintenance, or leave blank and charges will be the amount specified in the Default fee schedule.

 
3. Check the box if applicable:
Active This box will default to active. Click to remove check mark if the Company becomes 
inactive/no longer a valid Insurance Company.
Show Legacy ID If checked, the Legacy numbers entered in the Company information will be 
included on all claims.
Default Electronic Check box if claims for this insurance company will go to the payer 
electronically. If not checked, claims will be printed on a CMS 1500 form. 

Note: If a Payer/Insurance Company normally accepts only paper claims, but claims will be sent 
to Gateway EDI to drop to paper and forward to the Payer, see next step for setup
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Electronic Insurance Submission Setup

4. Electronic Submission Info is inserted into the Electronic Insurance files to identify Payer, 
Clearinghouse and Type of claim. To automatically populate some of this information, it is 
recommended that the Claims Options  section be completed prior to setting up the Insurance 
companies. 

Note:  All fields are required when submitting electronic claims. Payer ID and Receiver ID.will be 
provided by your Clearinghouse.

Payer Qualifier-Identifies type of Payer ID. (For most Payers, this will be ZZ-Mutually Defined)
Payer ID-Identifies the Payer of claims submitted for this Insurance Company. (GatewayEDI will 
provide a list of your Payer IDs)
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Note: All payers that will be sent electronically to Gateway EDI and then dropped to paper claim by 
Gateway, will be Payer ID 00010

Clearinghouse Name-Identifies the Clearinghouse  (Info entered in Claims Options )
Clearinghouse ID-Identifies the Clearinghouse.  (Info entered in Claims Options)
Type - Identifies the Type of Claim
Receiver Qualifier-Identies the Receiver ID.  (Info entered in Claims Options)
Receiver ID-Identifies the Receiver of the Electronic file submitted.  (Info entered in Claims 
Options)

Additional IDs

5. Enter additional ID numbers if necessary for the claim processor to identify the entity.
EIN: Payer EIN
Claim Office #: Payer Claim Office Number
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NAIC Code: Payer National Association of Insurance Commissioners Code

Note: Most Payers will not require this info, and if it's added into the claim when not required, the 
claim will deny.

Rendering Provider Setup for Insurance Company

The information in Provider Setup section is required when filing claims, and is used to file to 
identify the Rendering Provider of Service, The Pay To Group/Provider and other identifiers.

6. Click the New Provider Mapping button (Green +) to add Providers of Service to this Insurance 
Company. 
7.  Click to highlight a Provider and Click the Add button to open the Edit Billing Information dialog.
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Edit Billing/Pay To Information for Payer-Additional IDs 

Edit Billing Information dialog is used to identify Billing/Pay To information (top portion) and 
Rendering Provider of service (bottom portion). This information will be included on all claims 
submitted to this Insurance Company.  

8. Insurance Payment To: This section is populated with data used when setting up Manage 
Groups. Verify that this is the correct Pay To information. To edit information or add additional IDs 
required for this payer, click to place a check mark in the Override Group Values box. 
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9. Tax ID: If the Pay To provider is an individual and payments are reported to his Social Security 
number, Click SSN and type social security (Block 25)

10. Legacy ID for paper claims: When filing paper claims, if payer requires a Billing legacy 
number in addition to the Billing NPI, select legacy qualifier from the drop down list and enter the 
legacy ID. If not required, leave blank.

11. Electronic Claims-Additional IDs: Add additional ID numbers, if required for selected payer. 
Note: Most payers will not require this information, and if it's added to this setup when not 
required, the claim will reject. 

12. Pay-To Address:  If Pay-To address is different than Billing Provider street address, enter that 
information here. If group does not have a P.O.  or lock box, leave blank.

13. Eligibility Request Info: Some payers require a Tax ID or a legacy ID to be sent with an 
eligibility request. You will get a message alerting you when you are checking eligibility, if this is 
required. Enter those IDs in the Receiver ID field. If a payer does not require one, this section 
should be left blank. 

14. Select to check eligibility using the Group/Billing NPI or the Individual/Rendering provider ID.

Below is a list of some payers that do require a Legacy ID or a Tax ID  in step 13:

Payers requiring Legacy ID                        
• BCBS of Arkansas
• BCBS Michigan
• California Medicaid
• Maine Medicaid
• Mercy Health Plan of Arizona
• Ohio Medicaid
• University Family Care of Maricopa
• Wisconsin Medicaid Well Woman Program

Payers requiring Tax ID
• AFTRA
• American Postal Workers Union
• American Republic Insurance
• Amerigroup, Carefirst BCBS
• Cariten Healthcare
• Cariten Senior Healthcare
• Fallon Health Plan
• Keystone Mercy Health
• Kaiser Foundation Health Plan of Northwest
• Lovelace Health Plan
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• Lovelace Health Plan
• Mayo Management Services
• Mega Life
• Midwest National Life
• Physicians Mutual Insurance
• Preferred Health Systems
• Significa Benefit Services
• Texas CHIP
• Trustmark Insurance
• Writers Guild
15. Provider Information: This section is populated with data used when setting up Provider 
Manager . If this insurance requires a Rendering Provider Legacy number in addition to the NPI, 
use the drop down arrow to select an identifier for the ID and then type the ID into the field. (Block 
24j)
16. Electronic: Enter any additional IDs to be included on electronic claims, if required by this 
payer for Rendering Provider. 
17. Click Save.

Delete Insurance Company          Tools -> Insurance Companies

Tools -> Insurance Companies

1. Click on the Insurance Company to be deleted.  
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2. Click on the Remove Company Icon (Red X). You will be prompted to verify that you want to 
remove the selected insurance company. 

3.  You will be prompted to verify that you want to remove the selected insurance company. Yes to 
delete, No to cancel 

Note: Users must have security privileges to delete an Insurance company. Insurance 
demographics will have to be updated for any patients that  have the deleted insurance company 
in their information.
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13. Contacts/Referring Physicians (Block 17)

Tools -> Contacts

Additional information in SOAPedia

Add a new Contact/Referring Physician

1. Click Add New Contact button to create a new contact. 

Note: To edit an existing Contact, double click on contact name to open Edit Contact Information 
dialog. To delete a contact, click on the X next to contact name.

http://soapedia.mysoapware.com/010._Introduction_Guides/SOAPware_Setup/3._Master_Setup_Items-In_Random_Order/Contacts-Referrals
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1. Contact Information: Complete the Contact's basic demographic information. 

2. Provider Information: Enter the contact/referring physician's NPI, UPIN, State License, 
Specialty and Taxonomy code. To access the list of Taxonomy Codes, Click on the link 
http://www.wpc-edi.com/content/view/793/1

3. Insurance Information: If additional IDs are needed for referrals when filing with certain 
insurance companies, you can enter these IDs under Insurance Information. See below steps for 

http://www.wpc-edi.com/content/view/793/1
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adding additional IDs. 

Note: Most insurance companies require only the NPI number of the Referring Provider. If the 
selected insurance company requires additional IDs, proceed to step 5. If not, the Contact setup 
is complete for this Referring Provider.

Referring Provider Additional IDs

3. Click the New Insurance Mapping button in the Insurance Information section to open the 
Select Insurance Company dialog.

4. Begin typing the insurance company name in the field or click on a name from the list, and click 
Select to open Edit Contact ID dialog.

Note: Most insurance companies require only the NPI number of the Referring Provider. If the 
selected insurance company requires additional IDs, proceed to step 5. If not, the Contact setup 
is complete for this Referring Provider.
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Add additional IDs

5. Electronic Claims: Add the additional ID required by the selected insurance company. If UPIN 
or State License is required, you can click on the '+' to automatically add the ID from step 2.

6. Paper Claims: If a legacy ID is required in addition to referring provider NPI for paper claims,  
use the drop down to select the legacy ID Qualifier  followed by the number and then Click Save.



Practice Management 2012 User Manual  - 97

14. Flags/Notes Category Manager

Tools->Flags/Notes Category Manager

Add Notes and Flag patient accounts to alert user when scheduling or opening account.  

Add Category

1. Click the Add Category button
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Add Category Name, Description and Access 

2. Enter a Name for the Category.
3. Add Category Description.
4. To alert users with a pop up message when opening the patient account or chart,  select those 
individual users or click the Select All Users box to alert all users.
5.  To alert users by assigned Roles to be alerted by a pop up message when opening the patient 
account or chart, you can select that Role or click the Select All Roles box to alert all users 
assigned to the selected Role.
6. To alert users by assigned Groups to be alerted by a pop up message when opening the 
patient account or chart, you can select that Group or click the Select All Groups box to alert all 
users assigned to the selected Group.
7. Click OK to save the Category.



Practice Management 2012 User Manual  - 99

Edit or Remove Flags/Notes Category

8. Click to edit selected category
9. Click to remove selected category
10. Icons can be used to edit, delete or add categories.
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15. Custom Demographic Titles

Tools -> Custom Demographic Titles

The Custom Demographics section of the chart contains the information not otherwise contained 
elsewhere in the demographics area, but which may be needed in most patients' charts. Setting 
the custom demographics titles has changed slightly from SOAPware 4.x. Custom field 13 is a 
note or memo text box; it is used to store more information than the other fields.
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By editing custom demographics titles, you can add additional demographic fields to SOAPware, 
with names that you assign them. To modify the custom demographics headings:
1. Click Tools-Custom Demographic Titles
2. You will see a list of custom demographics text boxes. The current name of each field is shown 
in an edit box where you can enter the new name.
3. Fill in as many of these fields as you wish, then click Save to save your changes.
4. Click Save, then close SOAPware and restart to see the new titles displayed.
Note: This setting will change the titles of all custom demographic fields on all patients in the 
database.
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16. Set Structured CPT Options

Tools -> Options -> Structured CPT

Select Structured CPT Sub items

1. Select Sub items for the Structured CPT items when inserted in the Plan Section of the SOAP 
note for documenting Encounters/Visits.
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2. To exclude a sub item, click the box to remove the check mark. 

3. Screenshot of Structured SMARText item within the SOAP note using the select options above. 
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17. List Options

Tools menu  -> List Options

Edit Billing Related Lists (As Needed)

1. Billing Payment Types: Create the types of payments that are accepted in the clinic. Add any 
as needed.

2. Financial Classes: Edit/Add any needed Financial Classes to use for tracking patients.
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3. Schedule Appointment Status: Create any desired appointment statuses to match your clinic 
work flow.  

Billing Payment Types

1. Billing Payment Types: Create the types of payments that are accepted in the clinic. Add any 
as needed.
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Financial Classes

Add any financial classes that you need to track patients. Determine what type of financial class a 
patient has at a glance.

1. Double click on a financial class item in the list, or click the Create List Item button to add a 
new financial class.

2. Click Back Color and select a preset color, or click More Colors and choose a custom color. 
3. Click on the Fore Color drop down and select a preset color, or click More Colors and 

choose a custom color. This will edit the font of the appointment. Preview shows how the 
Patent's name will display in the Patient Account Information Bar when this financial class is 
selected in Demographics tab.

4. Click Save when done.
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Schedule Appointment Status

Add any appointment statues that you would like to use when tracking patient appointments.  

1. Double click on an appointment status item in the list, or click the Create List Item button to 
add a new status.

2. Edit the Text as needed.
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3. Click Back Color and select a preset color, or click More Colors and choose a custom color. 
4. Click on the Fore Color drop down and select a preset color, or click More Colors and 

choose a custom color. This will edit the font of the appointment.
5. Click Save when done.
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Updating CPT®, HCPCS, and 
ICD-9 codes 
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Download new quarterly/annual codes

Steps to download the latest database of CPT® HCPCS or ICD codes - When the below steps 
are followed and completed, any new or revised codes will be downloaded on your local 
database.

Clinical Suite Only: New codes will be automatically added to the Billing Maintenance databases, 
and revised codes, when downloaded on the SMARText Online library, will be updated in the 
Billing Maintenance databases. Deleted codes will have to be inactivated manually.

Download new codes in the SMARText Items dialog

1. Click on the SOAPware menu and select Chart.
2. When in the Chart domain, go to the Docutainers menu and select SMARText Items  (or hit F10 
on your keyboard). 
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Find the new code set on the SMARText Online Library

1. Make sure that you have the Include Online Library Items box checked. 

2. Enter the code needing to be downloaded into the Find box to access the new codes. NOTE: If 
there is a group of codes that start with the same few numbers or letters, you can enter those into 
the find box, and it will pull up all of the codes with that beginning set of numbers/letters. (For 
example, if you were wanting to pull up the grouping of office visit codes, you could enter 992 into 
the find box, and it will find all the office visits with those numbers. You can also type in a general 
description word, such as knee, xray, etc to search for groupings of codes.)

3. Click the Search button to search the entire online library for the new codes. 

4. Click the column header to sort Type. For Clinical Suite users, download ST Plan Item type. 
These codes will be entered in the Plan section of the SOAP note for billing purposes.

5. Click the downward facing Blue Arrow to update, as indicated in the image above.
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Download New Codes for 2013

1. Type !!!2013!!! into the Find field and click on the magnifying glass. Once the list appears, click 
on the first line shown.
2. Press down the Shift key on your keyboard. 
3. Using your mouse scroll all the way to the bottom of the list and click on the last item shown 
(while still having the Shift key held down). 
4. You should see every line item selected in blue. 
5. Let up on the Shift key and click the downward facing Blue Arrow to update, as indicated in the 
image above.
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Update Revised Codes for 2013

1. Type !!needsupdated-2013!! into the Find field and click on the magnifying glass to  search. 
Once the list appears, click on the first line shown.
2. Press down the Shift key on your keyboard. 
3. Using your mouse scroll all the way to the bottom of the list and click on the last item shown 
(while still having the Shift key held down). 
4. You should see every line item selected in blue. 
5. Let up on the Shift key and click the downward facing Blue Arrow to update, as indicated in the 
image above.
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PM Code database updated (Clinical Suite Only)

As soon as items are downloaded locally from the SMARText online library, the codes are brought 
over and made available in the Billing Maintenance Code databases. The updated and/or new 
codes will show a modified date as the date that the codes were downloaded and brought over. 
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Deleted Code Procedure

When a CPT®, HCPCS or ICD-9 code is deleted or no longer a valid code, it will be removed from 
the SMARText database but will have to be inactivated in Tools ->Billing Maintenance-> CPT 
Maintenance, HCPCS Maintenance and ICD Maintenance for the PM Code Databases.

Inactivate a code

1. To inactivate a CPT Code, place a check mark in the Inactive box. 
2. Click Save and repeat for each code on your list. 

This will not completely remove it from the database, but will archive it and hide it from view.
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Schedule Setup
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Activate Providers/Resources for a Facility

Steps on how to set scheduling defaults.

To access the Scheduler, go to the SOAPware menu and click Schedule.

Add a Facility

1. Click on the Tools menu.
2. Select Manage Facilities.
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Create a New Facility

Click the Create New Facility button, to setup a new facility. If you already have a facility setup, skip 
this lesson.
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Scheduler

Click the Scheduler tab to setup the clinic's defaults.
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Opening the Provider's Schedule Defaults

1. Click on a provider name. 
2. Click Edit.
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Making a Provider visible for the Clinic

1. Check the box next to Visible to activate the provider for the clinic.
2. Click OK.

Set Working Hours for the Provider

1. Click on a day.
2. Click Edit.
3. Enter the Start and End Times.
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4. Check to make the Provider Available for that day, in the select clinic, if needed.
5. Click OK.
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Provider/Resource Outlining

Setup outlining blocks for Providers and Resources to streamline their time in the office. 

Open the Facility Manager

1. Click on the Tools  menu. 
2. Select Manage Facilities.
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Edit a Facility

1. Select a Facility.
2. Click the Edit Facility button.
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Select the Scheduler Tab

Click on the Scheduler Tab.
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Select a Provider or Resource to Edit

1. Click to select a Physician. 
2. Click the Edit Provider Information button.

Note: This is the same process for Resources. To Edit a Resource, just click the tab Resources 
and follow the above steps.
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Open Outlining

Click on the Outlining tab.

Create an Outline

Click the Add Outline
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Set the Outline 

Outline Name: Name the type of appointments that should be scheduled in the designated time 
slot. (This name will show up to the left of the Schedule with the associated color, for schedulers 
to have a reference for the shading.)

Outline Color: Click the drop down and select a desired color to associate with the outline and be 
shown on the Schedule. 

Open Time: Set the time period for the outline. 

Days: Check all days that this outline and selected time will be in effect. 

Note: When scheduling, these outline blocks will not prevent any other appointments from being 
scheduled during the block. They are merely referential for front office staff to aid as a guide when 
scheduling. You can override, if needed.

Click OK when done. Repeat this for each outline for each Provider/Resource needed.
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Activate and view the Outline shading

1. Click on the Scheduler menu. 
2. Click on Coloring. 
3. Select Resources. 
4. Click By Outlines.

You should then see the coloring change on the Schedule and see the outline blocks you set up.
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Provider/Resource Recurrences

Setup recurring appointments for Providers and Resources to block out their schedule in the 
intervals selected and not allow any other appointments to be scheduled.

Open the Facility Manager

1. Click on the Tools  menu. 
2. Select Manage Facilities.



Practice Management 2012 User Manual  - 131

Edit a Facility

1. Select a Facility.
2. Click the Edit Facility button.
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Select the Scheduler Tab

Click on the Scheduler Tab.
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Select a Provider or Resource to Edit

1. Click to select a Physician. 
2. Click the Edit Provider Information button.

Note: This is the same process for Resources. To Edit a Resource, just click the tab Resources 
and follow the above steps.
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Open Recurrence Tab

Click on the Recurrence tab.

Create a Recurrence

Click the Add Recurrence.
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Setup the Recurrence.

Appointment Time: Set the Start Time and End Time for the specific recurrence.

Recurrence Pattern: You can set the intervals for the recurrence in this area. Below are the option:
  Daily: Setup the number of day intervals between occurrences or select to have the appointment 
set for every weekday (Monday - Friday).
  Weekly: Setup the number of week intervals between occurrences and check the specific days 
of the week for the appointment to occur.
  Monthly: Create the appointment on a particular day in month intervals (for example, every 5th 
day of every 3rd month, with the numbers being able to be customized by you). You can also 
indicate a particular day of every month for the appointment to occur.
  Yearly: Indicate every Month and Day for the year year or indicate the (first, second, third, fourth or 
last)  (day, weekday, weekend day, Sunday, Monday, Tuesday, Wednesday, Thursday, Friday or 
Saturday) of a select Month.

Range of Recurrences: Set recurrence to start by a certain date and end either after a set number 
of occurrences or by a set end date.  

Comments:  Name the recurrence in this field. The text entered here will be what is shown on the 
Recurrence from the Schedule. 
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Click Save. Repeat this for each recurrence needed for each Provider/Resource needed.
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Entering Facility Business Hours

Set up the hours of operation for a facility.

Tools > Manage Facilities 

Open the Facility

1. Select the Facility. 
2. Click Edit. 
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Scheduler

Click the Scheduler Tab.



Practice Management 2012 User Manual  - 139

Edit Business Hours

1. Click on a day of the week.

Edit the day

1.  Enter the Open Time of the clinic for the specific day.
2.  Enter the Close Time of the clinic for the specific day. 
3.  Check the box next to Is Open if the facility will be open for business on the specified day of the 
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week. 
4.  Click OK to save.

Update the Schedule

Click the Update button to update the Schedule.
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Creating Holidays/Closings

Set up the days the facility will be closed.

Tools -> Manage Facilities 

Open the facility.

1. Select the Facility. 
2. Click Edit. 
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Click Scheduler.

Click the Scheduler Tab.
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Create Facility Closings.

1. Click the Add Closing button. 

Edit the day.

1.  Enter the Name of the closing.
2.  Enter the Start and End Dates of the closing.
3.  Click OK to save.
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Update the Schedule.

Click the Update button to update the Schedule.
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Creating Scheduplates

Set up facility appointment types.

Tools -> Scheduplates

Open the Scheduplate Manager.

1. Click on the Scheduler menu.
2. Select Manage Scheduplates.
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Add a Scheduplate.

Click the Create New Template button. 

Enter Scheduplate information.

1. Type in a Scheduplate Name and Abbreviation. The abbreviation will be shown on the 
appointment at a glance, and the full scheduplate name will be helpful in selecting the correct 
appointment type. 
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2. Select a Background color to show on the appointment.
3. Select a Foreground color for the text displayed. (After selecting the background and foreground 
colors, the sample text will display what the appointment will look like on the Schedule.)

Adding a Resource.

Click the Add Resource button.

Entering Resource time.

1. Select the Resource to whom the scheduplate will apply. 
2. Enter the number of minutes needed, prior to the patient being seen by the Provider/Resource.
3. Enter the Duration of the appointment with the resource selected. This indicates the length of 
time needed with the Resource.
4. The Start Cushion indicates the amount of time needed to prepare the patient for the 
Provider/Resource's time. Enter the number of minutes by typing the number or clicking the 
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arrows.*
5. The End Cushion allows for any follow up work related to the appointment to be indicated and 
accounted. Enter the number of minutes by typing the number or clicking the arrows.*
6. Click Save.

*Both the Start and the End Cushion are designed to help prepare for the full length of the 
appointment. These fields are not necessary to create a scheduplate.

Update Scheduplates.

Click Update to save the scheduplate.
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Confirm Scheduled Appointments 

Confirm Appointments from Scheduler
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Select Patient

1. Select day using the calendar.
2. Double click on first patient to open account.
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Change Status 

2. Call Patient using information in Patient Info Bar.
3. Change Status.
4. Use arrows to navigate to next or previous account in the schedule for selected day.
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Menus and Toolbars
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SOAPware Menu

Provide orientation and descriptions of the SOAPware menus.

SOAPware Menu

Displays the various workspaces in SOAPware.
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Billing Menu

Provide a description and orientation of the Billing menu. 

Billing Menu

Provides access to the most commonly used billing related activities.
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Scheduler Menu

Provide a description an orientation of the Scheduler menu.

Scheduler Menu

Provides all of the Scheduling options and functionality needed for everyday use of the Schedule.
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Edit Menu

Provide a description of the Edit menu.

Edit Menu

Provides common editing tools. 
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Tools Menu

Provide a description and orientation of the Tools menu.

Tools Menu

Displays all of the master dialogs for setting up and customizing the SOAPware EMR and PMS.
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View Menu

Provide a description of the View menu.

View Menu

Provides various navigation tools to help with more quickly moving between workspaces.
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Help Menu

Provide a description and orientation of the Help menu.

Help Menu

Provides links to all of the available SOAPware resources to help with training and support of 
SOAPware.
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Patient Account Overview
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Looking Up a Patient Account

Learn how to search for an existing patient from the Chart Rack.

Pull up the Chart Rack

1. Click on the Billing menu. 
2. Select Patient Account. 

OR 

Hit Ctl + A on the keyboard.
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Search for a Patient

1. Select the type of information to search. The options are Birth Date, Chart #, Name, Phone # 
and Social Security #. The default option will be Name if nothing is selected. 
2. Type in a name or number  to search. If looking for a patient name, the system will search by 
last name. 

Chart rack is re-sizable. Hover over the edge or corner of the chart rack an drag your mouse to 
re-size.
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Select the Patient.

When the patient needed has been pulled up, click on the name and hit Select; or hit Enter on 
the keyboard.
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Creating a New Patient

How to create a new Patient Account. 

Pull up the Chart Rack

1. Click on the Billing menu. 
2. Select Patient Account. 

OR 

Hit Ctl + A on the keyboard.
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Create a New Patient

1. ALWAYS search the existing patient database for a patient BEFORE creating a new chart. This 
helps prevent duplicate charts from being created.
2. Click the Create Chart button.  

Enter First and Last Name.

1. Type in First and Last Name.
2. Click OK.
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Enter Demographics

Enter demographic information as provided. 
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Patient Information Bar

Show the highlights of the Patient Account Information bar.
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Patient Information At-A-Glance

Allows demographic and balance information to be easily seen without having to search.  



Practice Management 2012 User Manual  - 169

Schedule Tab

An overview of the patent's appointment details and history displayed on the Schedule tab.
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Schedule Tab - Patient Appointments

1. Visit Detail: Summary of the overall length of the appointment
2. Scheduplate: The appointment type 
3. Referral: Referring Provider
4. Facility:  Place of Service
5. Status: The status of the patient visit within the clinic's work flow. (This list is completely 
customizable by clinic.)
6. Recurrence: Sets recurrences of the visit, if needed. 
7. Resources: Allows the scheduling of one to multiple resources for one visit
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8. Visit Comments: Allows miscellaneous information and visit details to be entered and stored 
for the visit.
9. Verification: Indicates the date and user who verified the patient's insurance benefits and 
eligibility. 
Note: If appointment is moved, or rescheduled, the verification will have to be rechecked
10. Check-In: Allows a patient to be checked in with the click of a button. 
11. Take Co-Pay:  Allows a patient's co-pay to be taken at the beginning of the visit.
12. Visit List: Displays all of the patient's past, current and future appointments to be displayed in 
one place, to help prevent double booking an appointment. 
13. Today: Immediately selects the current day's visit. 
14. Print Visit: Prints out the selected visit.
15. New Visit: Creates a new appointment for the patient.
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Confirming Patient Appointments

By clicking the left and right arrows for a Resource, you can move to the previous or next 
appointment for that resource to confirm appointments, without ever having to go out and back in 
of each appointment on the Schedule.

When you want to mark a patient as Confirmed, you can select that status from the Status drop 
down as shown above and make a note in the visit columns, if you like.
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Demographics Tab 

Patient Demographic Information
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Patient Demographics

1. Patient Name: Title, First Name, Middle Initial, Last Name, Suffix
2. SSN: Social Security Number
3. Birth Date: Date of Birth is entered manually, and Age is automatically calculated.
4. Marital Status
5. Gender: Patient sex
6. Race: Important for meaningful use guidelines
7. Ethnicity: Important for meaningful use guidelines
8. Language: Important for meaningful use guidelines
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9. Patient Address
10. Contact Information: Phone and Email
11. Primary Provider: Provider within the Clinic that is treating the patient
12. Referring Provider: External provider who referred the patient to the clinic
13. Primary Care Physician
14. Preferred Pharmacy: Default pharmacy for sending the patient's prescriptions
15. Guarantor: Person/Entity that is financially responsible for the patient's account and balance
16. Financial Class: Indication of the patient's financial position.
17. Student Status: Indicates whether the student is an active student
18. Notes: Enter Internal notes pertaining to patient account
19. Print: Print patient demographics
20. Add Scan: Allows documents and forms to be scanned in as part of the patient's 
demographic profile. (The scanned document goes next to the General tab as a reference 
document.)
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Insurance Demographics Tab

Add patient insurance information to account
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Patient Insurance Policies

1. Primary Insurance Policy 
2. Secondary Insurance Policy
3. Change filing status:  Change the policy to Primary, Secondary, Tertiary or Inactivate a policy by 
dropping down and selecting from the list.
4. View: Displays details of the patient's insurance policy
5. Scanned Insurance Card(s): Display as tabs on the Insurance tab for reference
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Adding a New Insurance Policy

Click the Add New Policy button

Primary Insurance Policy Information

Type-Select policy type from drop down list. (For informational purposes only)
Company-Select from list of insurance companies. This is the listing created when setting up 
insurance companies from Tools->Insurance Companies.
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Policy Information
Policy # Type -Select Member ID-the subscriber’s identification number as assigned by the payer. 
(For example, Insured’s ID, Subscriber’s ID, Health Insurance Claim Number (HIC), etc.) Or select 
Unique Health ID-Required if the HIPAA Individual Patient Identifier is mandated use. If not 
required, select Member ID.
Policy #-Enter insurance information exactly as shown on patient's insurance card.

Payment Options 
Co-Pay or Co-Insurance amounts. The amount entered in the Co-Pay can be viewed at a glance 
in the patients information bar for reference.Status-Primary, Secondary,Tertiary or Inactive. 
Fee Schedule-Defaults to the fee schedule selected in the Insurance Company setup.

Insured Information 
This section defaults to the patient information entered in the demographics tab. If the patient is 
the insured, no changes are necessary. If the insured is someone other than the patient, you will 
need to enter that info here. Please see next step.
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Relation to Insured is other than Self

If Relation to insured is changed, all data from patient demographics is cleared and information 
can be manually added or can be added by clicking on the Select Guarantor icon, if the insured 
has been added to Payer/Non-Patient Accounts . Complete policy information exactly as it appears 
on insureds ID card.

Relation-Choose the patient's relationship to the insured from the drop down list. 
Is Person- Select Yes if the insured is a person or No if the insured is a non-person entity.
Name-Enter the insured information in the fields provided.
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Medicare Secondary Payer Insurance Policy Setup

If patient has Medicare as a secondary policy, the Medicare Secondary Type must be specified. 
This option will be added to the Secondary Policy in patient Insurance demographics tab.

Click the drop down arrow to select the appropriate code/reason Medicare is not the primary payer
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Check Insurance Eligibility

 
1. Click Check Eligibility Button to download patient insurance eligibility. Download will begin 
automatically.  
2. Click to Add Scan. For information on adding scanners, please click on the link. Scanning 
Set-Up & Options.

http://soapware.screenstepslive.com/s/documentation/m/new_user_manual_current/l/24701-scanning-set-up-options
http://soapware.screenstepslive.com/s/documentation/m/new_user_manual_current/l/24701-scanning-set-up-options
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Eligibility Warnings

Some payers require a legacy ID or Tax ID for checking eligibility. If this message pops up when 
checking eligibility, please click on link and refer to step 13 in the Insurance Company Setup. 
Setup Insurance Company 
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Custom Demographics Tab

Custom Demographics

Customizable Demographics

Allows unique patient information to be tracked and entered based on the clinic's preferences.
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Flags/Notes Tab 

Patient Account: Flags/Notes

Flags/Notes can also be created, edited and viewed within the Patient Account (for Clinical Suite 
customers).  To open the Patient Account, Click Billing > Patient Account.

Select the desired chart from the Chart Rack and click the Select button to open the Patient 
Account.
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When the Patient Account is opened, the Patient Flag! alerts window will display for authorized 
Users/Roles/Groups.  

Click the X in the top right corner of the Patient Flags! window, or press the ESC key to close the 
window.
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1. Click the Flags/Notes tab to view the patient's lis t.
2. The X button will allow you to remove/delete an existing flag/note from the patient's 

chart/account.
3. The Pencil icon will allow you to edit the existing flag/note.
4. The Add Note button will allow the user to add a new flag/note to the patient's chart/account.
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Ledger Tab

A summary of the patient's financial activity.
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Ledger Tab - Financial Summary

Double click on any line item to drill down and get more details.

1. Add Adjustment: Add an adjustment for the individual patient account, as needed.
2. Add Charge: Add a non-billable charge to the patient. Charges entered from the ledger will not 
be billed to insurance. (All charges to be submitted to Insurance must be processed in New 
Charges.)
3. Add Payment: Add a Payment on the patient's account and apply across all charges. 
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4. Print Receipt: Print a patient receipt on demand 
5. Create Claim: Create a Claim for visits posted prior to insurance information received. If a visit 
has already had claims produced, see Claims tab.

Payment lines are displayed in green shading, Adjustment lines in blue.

Charge Details

Double click any charge line item from the ledger to view the above details: 
  1. Dates of Service
  2. Rendering Provider
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  3. Procedure Code
  4. Units billed
  5. Charge per Unit
  6. Associated Diagnosis Codes
  7. Associated Modifiers
  8. Miscellaneous notes applying to the charge
  9.  Additional/Situational details relating to the procedure/charge at the charge level (Loop 
2400)
10. Payments or Adjustments that have been applied towards the charge.
11. Totals for the Charges, Personal or Insurance Payments, Adjustments and Related Balance
12. Miscellaneous details pertaining to the charge

Personal Payment Details

Double click any personal payment line item from the ledger to view the above details: 
1. Payer: The person making the payment
2. Payment Details: Payment method and amount
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3. Comments: Any miscellaneous information pertaining to the payment
4. Applied: Shows how the payment was applied across charges

Adjustment Details

Double click any adjustment line item from the ledger to view the above details: 
1. Date: Date the adjustment was entered
2. Adjustment code
3. Adjustment Description
4. Amount: Total adjustment amount applied to the patient's charges
5. Applied: The line item view of how the adjustment was applied to each charge.
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Family Tab

View a patient's family balance and pending claims.
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Family Balance

1. Guarantor: View the patient's guarantor
2. Add Dependents: Add dependents under the active patient to be included in the patient's family 
balance.
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Claims Tab

View all of the patients claims and any related claim details. 
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 Patient Claims View

1. Claims: A listing of all of the patient claims, both pending and submitted. 

2. Claim Details: The claim details listed in this section represent the claim that is selected in the 
Claims list above.

3. Double click the line item to further view the specific charge details.  
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4. View additional claim info.

5. Patients Primary insurance Policy.

6. Patients Secondary insurance Policy

7. To change the Status of a claim:

On Hold: If making changes, place a check mark in the On Hold box to move a claim to that 
section in the Claims Manager. The claim must be Rebuilt to include changes on the the visit. 
Processed: If you want to make the balance on a claim the patients responsibility, place  a check 
mark in Processed box. 
If the claim is in the Claims Manager, this will also remove it from the Claims Manager.  
If a claim is in the Processed status, but you want to resubmit to insurance and make it Insurance 
pending status, you can click to take the check mark out and resubmit claim. 

8. File With: Drop down to select Primary or Secondary policy. If a secondary claim has been 
generated, and the primary payer has automatically forwarded it to the secondary payer, remove 
the claim from the Claims Manager by selecting the Crossover option from the list.

9. Route: Select the routing to submit claim Paper or Electronic.
 
10. Paper Fill: Paper claims only allow for four diagnosis codes per visit. If you have more than 4 
codes per visit, you will need to make a selection if you want to uses the primary 4 codes and use 
the fewest pages or if you want to use more than four diagnosis codes and maintain order. 
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Statements Tab

View any patient statements that have been sent out and reproduce with the click of a button. Hold 
patient statements if you do not want a patient to receive monthly statements.
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Statements Tab

1. Double click on any statement listed to see the original statement sent.
2. If you do not want a patient to receive a statement when processing bulk statements, place a 

check mark in the box.
3. Click No to continue holding statements, click Yes to uncheck the box and patient will begin 

receiving statements.
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Note: If this patient is a guarantor and has dependents listed in the Family tab, go to each 
dependent's account and repeat steps 1-3 to hold those statements.
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New Charges Tab

Transaction entry for patient charges, payments and adjustments
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New Charges Tab

1. Add Charges for the patient account quickly. 
2. Add Payment across charges for the active patient and dependents or other patients, if 
needed, all from one screen.
3. Edit Charge Details by double clicking the line item.
4. Specify the Follow-up Action for the charges posted.
5. Select Route to file claim-Paper or Electronic. (Defaults to option selected in Insurance 
Company setup)



Practice Management 2012 User Manual  - 203

6. Any provider Follow-up Comments or instructions  entered by the provider on the billing 
statement will show up here.
7. Enter any Claim Comments to the billing staff when processing claims. 
8. Add an Adjustment and apply to visit.
9. Paper Fill: Paper claims only allow for four diagnosis codes per visit. If you have more than 4 
codes per visit, you will need to make a selection if you want to uses the primary 4 codes and use 
the fewest pages or if you want to use more than four diagnosis codes and maintain order.  
10. Check box to Print a receipt after posting, or click to remove check mark if no receipt is 
required.
11. Post charges, payments and adjustments to the patients ledger. If Submit to Insurance is 
selected and there is an active insurance policy for the patient, a claim will be automatically 
generated. 
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Locked Tabs

Unlocking Patient Account Tabs
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Locked Tabs due to Patient Account and Patient Chart In Use at the same time

When a patient chart is open, and a user tries to access the same patient's account while the 
chart is still open, certain tabs will be locked, as shown in the screen shot here. This will prevent 
any updates or changes made by one user from getting overwritten by another user. To unlock the 
tabs, the patient chart will have to be closed. 
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Tab/View is currently locked by another user

If a patient account is in use, and another user accesses the same patient account, you will get 
an alert that the view is currently locked by another user, and certain tabs will be locked, as shown 
in this screen shot. 
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Unlocking a Locked Tab

To unlock a locked tab, Click on the lock icon. Lock Information dialog will display the User, 
Machine and Date/Time another user was viewing this account, causing it to lock. Verify that 
nobody else is currently trying to edit/add information to the patient account, and click the Unlock 
button. Removing a lock may cause data loss. You will be prompted to verify that you want to 
unlock the view. Click Yes or No.
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Scheduling
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Changing Active Facility

Changing the active facility, if a multiple site practice. 

Scheduler menu -> Active Facility

Open Active Facility

1. Click on the Scheduler menu.
2. Select Active Facility.

Select the new Active Facility

1. Click the drop down menu to find the correct facility.
2. Click Select.
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Navigation

Show the various ways to move around in the Schedule.

Move Quickly between Days, Weeks, Months

1. Move back 1 day.
2. Move back 1 week.
3. Move back 1 month.
4. Move ahead 1 day.
5. Move ahead 1 week.
6. Move ahead 1 month. 
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Monthly Calendar

Click the arrows to move quickly to the date needed.
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Views

View the Schedule as Days, Weeks, Months, or Work Weeks. 

Scheduler menu -> View 

Select the appropriate Schedule View.

Select the view that allows the easiest and clearest view of the Schedule. 
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Time Increments

Set the time increments shown on the Schedule.

Scheduler menu -> Time

Select the Time Increment

Choose the option that best fits your practice's scheduling needs. The time increment selected 
here will be displayed to the left of your schedule.
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Coloring

Set the coloring for Appointments and Resources. 

Coloring for Appointments

1. Click on the Scheduler menu. 
2. Select Coloring. 
3. Select Appointments. 
4. Select either By Status or By Scheduplate. By Status will show the shading of the status as it 
changes, and not show the Scheduplate coloring. By Scheduplate will the shading associated 
with the Scheduplate and not show the status color changes. 



Practice Management 2012 User Manual  - 215

Coloring for Resources

1. Click on the Scheduler menu. 
2. Select Coloring. 
3. Select Resources. 
4. Select either By Working Hours or By Outlines. By Working Hours will only show the hours the 
Provider is available to see patients in the clinic. By Outlines will show the outline shading 
associated with how the providers have indicated they want their days scheduled.
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Export the Schedule

Export the clinic schedule.

Export the Schedule.

1. Select the Scheduler menu.
2. Click on Exports.
3. Select Export Schedule. 
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Select the Facilities/Resources to Export 

1. Check the boxes of the Facilities to be shown.
2. Select the Resources whose schedules need to be exported. 
3. Enter the range of dates to be exported. 
4. Check to include the Visit Comments on the report as reference, if needed. 
5. Click Select.  The file will be exported as a CSV file.
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Schedule Reports

Access reports on the Schedule data.

Scheduler -> Reports

Print various Schedule Reports

1. Go to the Scheduler menu. 
2. Click on Reports. 
3. Status Report: View a summary of patients based on their appointment status.
4. Patient Report: Provides both a summary of the specified patient's appointments, but also 
provides a breakdown of the time spent at each status of each appointment.
5. Print Simple Schedule: Provides a summary of the appointments scheduled by Provider. 
Indicates the Time, Patient Name, Phone Number, Scheduplate, Status and visit Comments.
6. Print Advanced Schedule: Provides a summary of appointments scheduled across Facilities 
and Resources. Time, Patient Name, Phone Number, Scheduplate, Status and visit Comments.
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Searching for Available Appointments

Find Open Appointments

Scheduler menu -> Find Open Appointment

Find Open Appointment

1. Click on the Scheduler menu. 
2. Select Find Open Appointments. 
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Enter Basic Search Criteria

1. Select the Resource needed from the drop down menu.
2. Enter the date ranges for the possible appointment.
3. Enter the Start and End Cushions that the appointment will need to have.
4. Enter the Duration for the appointment needed. 
5. Click Search. 
6. If a suitable appointment has been found, select the appointment time.
7. Click Select.
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Enter Advanced Search Criteria 

1. Check the Facility needed for the appointment.
2. Enter the date ranges for the possible appointment.
3. Select a preferred Scheduplate that the appointment will need to have.
4. Add a Provider/Resource to search.
5. Click Search. 
6. If a suitable appointment has been found, select the appointment time.
7. Click Select.
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Scheduling an Appointment

Schedule a Patient Appointment

Double Click on a Needed Time Slot

1. The Chart Rack will be pulled up. 
2. Type in the Patient Name. 
3. When the correct patient is pulled up, click Select or double click the patient.
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Schedule Tab - Patient Appointments

Enter the below Appointment information, as needed:

1. Visit Detail: Summary of the overall length of the appointment
2. Scheduplate: The appointment type 
3. Referral: Referring Provider
4. Facility:  Place of Service
5. Status: The status of the patient visit within the clinic's work flow. (This list is completely 
customizable by clinic.)
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6. Recurrence: Sets recurrences of the visit, if needed. 
7. Resources: Allows the scheduling of one to multiple resources for one visit
8. Visit Comments: Allows miscellaneous information and visit details to be entered and stored 
for the visit.
9. Verification: Indicates the date and user who verified the patient's insurance benefits and 
eligibility. 
Note: If appointment is moved, or rescheduled, the verification will have to be rechecked
10. Check-In: Allows a patient to be checked in with the click of a button. 
11. Take Co-Pay:  Allows a patient's co-pay to be taken at the beginning of the visit.
12. Visit List: Displays all of the patient's past, current and future appointments to be displayed in 
one place, to help prevent double booking an appointment. 
13. Today: Immediately selects the current day's visit. 
14. Print Visit: Prints out the selected visit.
15. New Visit: Creates a new appointment for the patient.
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Moving an Appointment

Moving an Appointment  to a different time slot

Dragging and Dropping

1. Click to select the appointment.
2. With the left mouse button held down, drag the appointment to the desired time slot. The 
appointment should then be placed at a new time, and the patient's appointment details updated 
automatically. 
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Cutting and Pasting

1. Click to select the appointment. 
2. Right click on the mouse and select Cut.
3. Click the desired time slot. Right click on the mouse and select Paste. The appointment 
should then be placed at a new time, and the patient's appointment details updated automatically. 
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Deleting an Appointment

Delete a patient appointment

Delete an Appointment

1. Click to select the appointment.
2. Right click the mouse and select Delete, or hit Delete on the keyboard. (A warning will pop up 
to make sure the appointment is to be deleted. Click Yes to continue or No to cancel.)
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Changing Appointment Status

Changing an Appointment Status

Right Click to Change Appointment Status

1. Click to select the appointment. 
2. Select the needed status for the appointment. (The status should be updated automatically on 
the Schedule and in the patient account.)
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Scheduling Repeat Appointments

Setting up repeat appointments.

Open the Patient Account

1. Double Click the appointment, needing to be repeated.
2. The Schedule Tab will open. 
3. Click Recurrence.
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Recurrence Management

Click the Create Recurrence button.
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Set the Recurrence Pattern

1. Enter the appointment time.
2. Select whether the appointment will be on a Daily, Weekly, Monthly or Yearly basis. 
3. Indicate how long the recurrence will take place. Select the Start Date, as well as either the 
number of occurrences for the appointment or an End Date for the recurrence.
4. Click Save. The recurring appointments should be scheduled, and the patient account updated 
automatically. 
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Transaction Entry 
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Workflow - Clinical Documentation to Claim Creation

This lesson provides a recommended workflow for 
• Documenting the clinical visit and entering diagnosis and charge (CPT/HCPCS) codes
• Creating a billing statement
• Posting the billing statement to front office/billers
• Processing charges
• Creating a claim, as needed.

Note: This lesson will not be covering all of the steps/processes needed to fully document a 
clinical encounter in the SOAPnote. The 2 sections in the SOAPNote that will be highlighted will be 
the Assessment section and the Plan section. Diagnosis codes will be entered into the 
Assessment section, and CPT/HCPCS codes will be entered into the Plan section. These 2 
sections will be the two key areas that will transfer to the SW Practice Management system and 
primarily affect the billing/claims.
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Create the SOAPnote

With the patient's chart open, in the Charts workspace of SOAPware: 
1. Click on the SOAPNotes tab,
2. Click the Create Docutainer button to create a new encounter.
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Enter the Diagnosis Codes for the visit (Assessment Section)

1. Click into the Assessment section to activate.
2. There are several methods in which to enter diagosis codes into the Assessment section. 

Some of the most common methods are:
        - Selecting from the SMARText Quick Access list (This list will auto-populate with the most 
common diagnosis codes used by the user logged into SOAPware. To access this window, click 
on the Tools menu and click SMARText Quick Access. You can drag and drop that window to pin 
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to an area of the chart, if desired. The list will be begin populating as you begin to use the system. 
The most commonly used codes will default towards the top.)
        - Typing in a descriptive word and searching the database  by hitting F10 on your keyboard.
        - Creating a custom picklist of your most common diagnosis codes. 
        - Defaulting the codes needed into a specific template that is associated with the type of 
visit. 
3. Enter the needed diagnosis codes into the Assessment Section. (Sample shown in above 
image.)
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Enter the CPT/HCPCS Codes for the visit (Plan section)

1. Click into the Plan section to activate.
2. There are several methods in which to enter CPT/HCPCS codes into the Plan section. Some 

of the most common methods are:
        - Selecting from the SMARText Quick Access list (This list will auto-populate with the most 
common CPT/HCPCS codes used by the user logged into SOAPware. To access this window, 
click on the Tools menu and click SMARText Quick Access. You can drag and drop that window to 
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pin to an area of the chart, if desired.The list will be begin populating as you begin to use the 
system. The most commonly used codes will default towards the top.)
        - Typing in a descriptive word and searching the database  by hitting F10 on your keyboard.
        - Creating a custom picklist of your most common CPT/HCPCS codes. 
        - Defaulting the codes needed into a specific template that is associated with the type of 
visit. 
3. Enter the needed CPT/HCPCS codes into the Plan Section. (Sample shown in above image.)
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Associate diagnosis codes with each CPT/HCPCS code 

1. Click the Related Dxs wording for each procedure (CPT/HCPCS) code entered.
2. Check the applicable diagnosis codes that relate to the procedure, as shown in the 

SMARText Quick Access window.
3. Optional: If you would like to specifically order the diagnosis codes at this point, click the cell 

in the Order column to indicate the number order for each diagnosis. If the order is not 
specifically selected in this column, the order will default to the order in which the diagnosis 
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are checked.
4. Optional: Click on the Modifiers wording to associate any modifiers as needed for the 

procedure.

Create the Billing Statement

Click the View Billing Statement button. 
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Optional: Add Document task for Superbill Creation

When a billing statement is created, a window will pop up to associate a task with the new billing 
statement created. If you have a user in your clinic that will post these at a later time, this task can 
be assigned to them at this time, if desired. The purpose of this task box is to facilitate a method 
of tracking superbills that have been created and ensure that they get posted and not overlooked, 
resulting in lost revenue.

1. Click Add to add the task.
2. Click Cancel to not add a task.

IMPORTANT: Once the Billing Statement has been posted, this task will automatically be removed 
from the assigned user's task list.



Practice Management 2012 User Manual  - 242

Review the Billing Statement

1. Procedure codes are listed.
2. Associated diagnosis codes are displayed next to the procedure code.
3. Associated modifiers are displayed next to the procedure code.
4. Optional: If you need to remove a procedure from being billed, you can click the X to the left to 

remove the item from the billing statement.
5. Notes can be typed in to relay any specific information to front office/biling staff, pertaining to 

the visit.
6. Click the Post Superbill button to post the billing statement.

Note: The Owner listed at the top of the billing statement will be the active provider in SOAPware 
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when the billing statement was created. The Facility that is displayed will be the Active Facility on 
the Scheduler. Both Owner and Facility can be changed on the billing statement as needed by 
clicking each dropdown.

Add Document Task for Superbill Posted 

1. The User selected (in the Superbill Task User field) in the Misc tab of Provider Manager will 
default to be assigned this task. (Until a user has been set in Provider Manager, the task will 
default to the physician's name, but can be changed from this dialog as needed.)

2. Click Create to add the task for the specified user.

Note: If, under the Misc Tab in the Provider Manager, the checkbox has been checked to 
Auto-Create Post Superbill Task, this pop-up window will not be displayed. This task will 
automatically be sent to the designated staff member, who is set up as the Superbill Task User in 
the Misc Tab of the Provider Manager.
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Processing the Posted Billing Statement

From any location in SOAPware, the Task list can be displayed by going to the SOAPware menu 
and clicking Tasks. If front office staff are processing the posted billing statements/superbills and 
checking out patients, the task list can be docked within the Scheduler to allow for easy viewing of 
newly posted superbills/charges. If a back office billing staff member is processing these 
superbills, they can simply pull up their task list wherever it is convenient for them within 
SOAPware. 

1. With the appropriate user selected at the top of the task list, the newly posted superbill will be 
displayed in the list.

2. To process the visit, double click the line item to open the patient's New Charges tab.

If you would like for your Task list to display the description, patient name and time modified to the 
left (as is shown in the above screen), drag and drop any of the columns around as needed.
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Process/Post Visit Charges and Create Claim (As Needed)

1. Double click on the charge to review for any changes.
2. To change claim level information, click on More Info and edit as needed.
3. If a co-pay was taken when the patient checked in, you can manually apply that co-pay to the 

newly posted charges by clicking Apply Co-Pay and distributing as needed.
4. If you need to take a new payment, click Add Payment.
5. If the patient has an active insurance policy, the Follow-Up Action will default to Submit to 

Insurance. If Submit to Insurance is selected as the Follow-Up Action, a claim will be 
created when the visit is posted. If you do not want to create a claim, select Do Not File. 
Patient Responsibility from the Follow Up Action drop down.
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6. If there is a Primary Insurance policy for the patient, it will be listed here. The policy can be 
changed/switched to another policy if needed by clicking the drop down and changing.

7. The route of the claim will be defaulted from the Default Electronic option that was selected in 
the master Insurance Company setup. If Default Electronic was checked at the Insurance 
Company level, electronic claim submission will default here. If Default electronic was NOT 
checked, the default claim submission method will be paper. However, the claim route can 
be changed from the default at any time.

8. If there is a Secondary Insurance policy for the patient, it will be listed here. The policy can be 
changed/switched to another policy if needed by clicking the drop down and changing.

9. If submitting an electronic claim for Primary and Secondary, and the claim is being sent to 
Gateway EDI, Gateway will try to send the secondary electronically, if possible. If you need to 
generate a secondary claim directly out of SOAPware without going through Gateway EDI, the 
claim will be sent as a paper claim.

10. Post the visit to the ledger, when finalized. If a claim is generated, it will show in the patient's 
Claims tab, as well as in the SOAPware Claims Manager for scrubbing and further 
processing. Once the visit has been posted, the Post Superbill task will be marked as 
completed on the user's task list.
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Post a Superbill/Billing Statement from Patient Chart
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Post a Superbill/Billing Statement from Chart

1. An encounter/visit should already be documented in the SOAP note section of the Patient 
Chart. The date of service will default to the encounter date unless you change the date in the 
sub-items in the Structured Plan item. 

2. Structured SMARText items must be used in the Plan and Assessment fields as shown in the 
screenshot.

3. Click to view Billing Statement.
4. Click the Post Superbill icon.
5. Dialog will display with message The superbill was successfully posted. Click OK.
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Open Patient Account in Billing using Task Manager

If a user has been assigned as the Superbill Task User in Provider Manager, that user can 
access the list of Posted Superbills to complete the billing workflow from the Task Manager.

Go to SOAPware in the main menu and click on Tasks to open the Task Manager.

1. Use the drop down option to select user.
2. Use the drop down option to Show Assigned Tasks. 
3. Double Click on Patient name to open the patient account.

You can also open the patient account by following the next step.
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Open Patient Account in Billing using Chart Rack

Go to the Billing menu, then click Patient Account

1. Search Chart Rack for Patient Account. This example shows search by Name. Begin Typing 
patient last name until the patient is visible in the list of patients.

2. Click to highlight Patient from the Chart Rack list and then Click Select. Patient account will 
open.
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View Posted charges in New Charges Tab

Patient account will open to the New Charges Tab when a Superbill has been posted to Billing. 
The upper section displays Patient demographic details and Personal/Family account balances.

The Center section lists Visit details as documented in the SOAP note section of the patient chart. 
Charges are added for the Procedure Codes and can be edited by Double Clicking on the line of 
the charge as described in the Edit/Update Charges lesson. Payments, Adjustments and 
Additional Charges can be added manually, as needed.
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The bottom section allows the user to:
1. Verify Insurance policy information for patient  
2. Set follow up action for the claim. If insurance information is entered in the Patient 

Demographics, this will default to Submit to Insurance. 
3. Select Routing for claim-Paper or Electronic. This will default to option selected in the 

Insurance Company setup for the selected insurance.
4. Check as Incomplete, allowing the user to close out of the account and come back later to 

finish the check out process. 
5. Print a Receipt when the visit is posted to the ledger.
6. Displays Doctor Comments typed in Billing Statement Tab.
7. Type free text Comments pertaining to the claim (informational only) 
8. Add personal Payment to account
9. Post transactions to Patients Ledger
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Transfer Credit Balance 

Transfer a credit on one visit and apply to another visit. 

Note: Adjustment codes will have to be set up in Adjustment Maintenance before this can be done.
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Adjust Credit

1. Open the Ledger tab. 
2. Select the visit with a credit and click to highlight.
3. Click on the Add Adjustment button.
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4. Type adjustment code .
5. Click the arrow on the line with the credit and type '-' and then the amount to transfer. In our 
example we typed -2.00

The total amount in the Applied column will display in parentheses (2.00)

6. Click Save.
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Apply Credit

7. Click to highlight the visit to which the credit will be applied.
8. Click Add Adjustment button.
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9. Type adjustment code for balance transfer.
10. Type credit amount as shown in the Applied column. 2.00
11. Click Save.
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More Visit Information Claim Level  

Billing -> Patient Account -> New Charges Tab ->More Info
or
Billing->Patient Account->Claims tab->Select claim from list->More Info

The More Info dialog consists of several tabs for additional visit information needed by payers to 
process claims. Many specialties require specific dates, certification numbers, etc. Additional 
information can be added by clicking on the appropriate tabs. The information entered here will be 
at the claim level and will apply to all charges within the claim. Unless this additional information 
is required by the payer for your specialty, do not add any additional information.

For charge level only information, you can add information in the Charge Details by double 
clicking on a specific charge in New Charges tab or when editing charges in the patient Claims 
tab.

More Info Dialog

1. Type 
 If claim is related to an accident, place a check mark in box next to appropriate type of accident. 
Electronic claims allow for up to two types, CMS 1500 paper claims allow for only one type. If two 
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boxes are checked for paper claims, the first type checked will print on claim. To add Illness, 
Injury, or Pregnancy dates, please see Dates tab

2. Special Program Codes
Special Program: Code indicating the Special Program under which the services rendered to the 
patient were performed
Delay Reason: Code indicating the reason a request was delayed

3. Primary  
Release of Information Signature: Code indicating whether the provider has on file a signed 
statement by the patient authorizing the release of medical data to other organizations
Signature Executed for Patient: Code indicating how the patient or subscriber authorization 
signatures were obtained and how they are being retained by the provider

4. Secondary 
Release of Information Signature: Code indicating whether the provider has on file a signed 
statement by the patient authorizing the release of medical data to other organizations
Signature Executed for Patient: Code indicating how the patient or subscriber authorization 
signatures were obtained and how they are being retained by the provider



Practice Management 2012 User Manual  - 262

More Info Ambulance-Claim Level

Billing -> Patient Account -> New Charges Tab ->More Info
or
Billing->Patient Account->Claims tab->Select claim from list->More Info

The More Info dialog consists of several tabs for additional visit information needed by payers to 
process claims. Many specialties require specific dates, certification numbers, etc. Additional 
information can be added by clicking on the appropriate tabs. The information entered here will be 
at the claim level and will apply to all charges within the claim. Unless this additional information 
is required by the payer for your specialty, do not add any additional information.

For charge level only information, you can add information in the Charge Details by double 
clicking on a specific charge in New Charges tab or when editing charges in the patient Claims 
tab.
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More Info for Ambulance Claims

1. Pick Up Address: Enter full address
2. Drop Off Address: Enter full address
3. Ambulance Certification: Check Y or N if applicable. 
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More Info Ambulance (Continued)

4. Reason for Ambulance
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More Info Contract-Claim Level

Billing -> Patient Account -> New Charges Tab ->More Info
or
Billing->Patient Account->Claims tab->Select claim from list->More Info

The More Info dialog consists of several tabs for additional visit information needed by payers to 
process claims. Many specialties require specific dates, certification numbers, etc. Additional 
information can be added by clicking on the appropriate tabs. The information entered here will be 
at the claim level and will apply to all charges within the claim. Unless this additional information 
is required by the payer for your specialty, do not add any additional information.

For charge level only information, you can add information in the Charge Details by double 
clicking on a specific charge in New Charges tab or when editing charges in the patient Claims 
tab.

More Info Contract Type Information

Contract Type: Select Contract Type from drop down list and complete remaining fields, as 
required by payer
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More Info Dates-Claim Level

Billing -> Patient Account -> New Charges Tab ->More Info
or
Billing->Patient Account->Claims tab->Select claim from list->More Info

The More Info dialog consists of several tabs for additional visit information needed by payers to 
process claims. Many specialties require specific dates, certification numbers, etc. Additional 
information can be added by clicking on the appropriate tabs. The information entered here will be 
at the claim level and will apply to all charges within the claim. Unless this additional information 
is required by the payer for your specialty, do not add any additional information.

For charge level only information, you can add information in the Charge Details by double 
clicking on a specific charge in New Charges tab or when editing charges in the patient Claims 
tab.

More Info  

1. Illness, Injury or Pregnancy-Select date from drop down calendar for Accident, Onset of 
Current illness or Last Menstrual period. This will automatically add the date for Current IIP
2. Patient Treatment Dates -Add dates as required by payers for your specialty
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3. Hospital , Disability Dates-Select dates from drop down calendars for Workers Comp- Not 
Work From, Disability-Disability From/To, Hospital admit and discharge-Hospital From/To 
Care-Care From/To dates  
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More Info File Information-Claim Level

Billing -> Patient Account -> New Charges Tab ->More Info
or
Billing->Patient Account->Claims tab->Select claim from list->More Info

The More Info dialog consists of several tabs for additional visit information needed by payers to 
process claims. Many specialties require specific dates, certification numbers, etc. Additional 
information can be added by clicking on the appropriate tabs. The information entered here will be 
at the claim level and will apply to all charges within the claim. Unless this additional information 
is required by the payer for your specialty, do not add any additional information.

For charge level only information, you can add information in the Charge Details by double 
clicking on a specific charge in New Charges tab or when editing charges in the patient Claims 
tab.

More Info File Information Tab

File Information: 
Fixed Format Information 
Data in fixed format agreed upon by sender and receiver
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At the time of publication of this implementation, K3 segments have
no specific use. The K3 segment is expected to be used only when
necessary to meet the unexpected data requirement of a legislative
authority.
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More Info Reserved for Local Use (Box 19)-Claim Level

Billing -> Patient Account -> New Charges Tab ->More Info
or
Billing->Patient Account->Claims tab->Select claim from list->More Info

The More Info dialog consists of several tabs for additional visit information needed by payers to 
process claims. Many specialties require specific dates, certification numbers, etc. Additional 
information can be added by clicking on the appropriate tabs. The information entered here will be 
at the claim level and will apply to all charges within the claim. Unless this additional information 
is required by the payer for your specialty, do not add any additional information.

For charge level only information, you can add information in the Charge Details by double 
clicking on a specific charge in New Charges tab or when editing charges in the patient Claims 
tab.
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More Info Misc Details-Reserved for Local Use (CMS 1500 Block 19)  

Please refer to the most current instructions from the applicable public or private payer
regarding the use of this field. Some payers ask for certain identifiers in this field. If identifiers are 
reported
in this field, enter the appropriate qualifiers describing the identifier. Do not enter a space, 
hyphen, or other
separator between the qualifier code and the number.



Practice Management 2012 User Manual  - 272

More Info Medicaid Resubmission Number for CMS 1500 paper claim

Billing -> Patient Account -> New Charges Tab ->More Info
or
Billing->Patient Account->Claims tab->Select claim from list->More Info

The More Info dialog consists of several tabs for additional visit information needed by payers to 
process claims. Many specialties require specific dates, certification numbers, etc. Additional 
information can be added by clicking on the appropriate tabs. The information entered here will be 
at the claim level and will apply to all charges within the claim. Unless this additional information 
is required by the payer for your specialty, do not add any additional information.

For charge level only information, you can add information in the Charge Details by double 
clicking on a specific charge in New Charges tab or when editing charges in the patient Claims 
tab.
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Medicaid Resubmission Number

Enter Medicaid Resubmission number to appear in block 22 on the CMS 1500 claim form
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More Info Misc Details-Claim Notes

Billing -> Patient Account -> New Charges Tab ->More Info
or
Billing->Patient Account->Claims tab->Select claim from list->More Info

The More Info dialog consists of several tabs for additional visit information needed by payers to 
process claims. Many specialties require specific dates, certification numbers, etc. Additional 
information can be added by clicking on the appropriate tabs. The information entered here will be 
at the claim level and will apply to all charges within the claim. Unless this additional information 
is required by the payer for your specialty, do not add any additional information.

For charge level only information, you can add information in the Charge Details by double 
clicking on a specific charge in New Charges tab or when editing charges in the patient Claims 
tab.
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Claim Notes (Loops 2300  NTE01, NTE02)

To transmit information in a free-form format, if necessary, for comment or
special instruction at the Claim Level.

Text: Type free text
Type:  Select type of note from drop down list
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More Info Misc Details-Original Reference Number/ICN

Billing -> Patient Account -> New Charges Tab ->More Info
or
Billing->Patient Account->Claims tab->Select claim from list->More Info

The More Info dialog consists of several tabs for additional visit information needed by payers to 
process claims. Many specialties require specific dates, certification numbers, etc. Additional 
information can be added by clicking on the appropriate tabs. The information entered here will be 
at the claim level and will apply to all charges within the claim. Unless this additional information 
is required by the payer for your specialty, do not add any additional information.

For charge level only information, you can add information in the Charge Details by double 
clicking on a specific charge in New Charges tab or when editing charges in the patient Claims 
tab.
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More Info Misc Details-Original Reference Number/ICN

 If claim submission is Replacement claim, the ICN or Original reference number will be entered 
here.

1. Number: Enter ICN/Original Reference Number as shown on explanation of benefits or 
rejection report
2. Policy ID: Select payer from drop down list. This list is pulled from the insurance policy 
information in patient Insurance demographics
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More Info Misc Details-Lab CLIA number

Billing -> Patient Account -> New Charges Tab ->More Info
or
Billing->Patient Account->Claims tab->Select claim from list->More Info

The More Info dialog consists of several tabs for additional visit information needed by payers to 
process claims. Many specialties require specific dates, certification numbers, etc. Additional 
information can be added by clicking on the appropriate tabs. The information entered here will be 
at the claim level and will apply to all charges within the claim. Unless this additional information 
is required by the payer for your specialty, do not add any additional information.

For charge level only information, you can add information in the Charge Details by double 
clicking on a specific charge in New Charges tab or when editing charges in the patient Claims 
tab.
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More Info Misc Details-Lab CLIA number (Loop 2300 REF02 with X4 Qualifier)

Lab: The Lab will default to the Active Facility if the lab codes have been selected to add the CLIA 
number to the claims during the system setup.If visits/charges are created for facilities outside 
the main facility (physical address indicated in
Manage Groups), those facilities will still have to be selected in Providers tab->Service Facility, 
and the lab will need to be added in Misc Details tab, as in previous versions. The CLIA number 
will be included in the claim file and pulled from the Facility Manager.

1. Click on the drop down arrow
2. Select the facility where the labs are performed from the list
3. Click Save
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More Info Misc Details-EPSDT

Billing -> Patient Account -> New Charges Tab ->More Info
or
Billing->Patient Account->Claims tab->Select claim from list->More Info

The More Info dialog consists of several tabs for additional visit information needed by payers to 
process claims. Many specialties require specific dates, certification numbers, etc. Additional 
information can be added by clicking on the appropriate tabs. The information entered here will be 
at the claim level and will apply to all charges within the claim. Unless this additional information 
is required by the payer for your specialty, do not add any additional information.

For charge level only information, you can add information in the Charge Details by double 
clicking on a specific charge in New Charges tab or when editing charges in the patient Claims 
tab.
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More Info Misc Details-EPSDT

Code: If services are EPSDT related, use drop down list and select appropriate code for visit. 
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More Info Misc Details-Spinal Manipulation

Billing -> Patient Account -> New Charges Tab ->More Info
or
Billing->Patient Account->Claims tab->Select claim from list->More Info

The More Info dialog consists of several tabs for additional visit information needed by payers to 
process claims. Many specialties require specific dates, certification numbers, etc. Additional 
information can be added by clicking on the appropriate tabs. The information entered here will be 
at the claim level and will apply to all charges within the claim. Unless this additional information 
is required by the payer for your specialty, do not add any additional information.

For charge level only information, you can add information in the Charge Details by double 
clicking on a specific charge in New Charges tab or when editing charges in the patient Claims 
tab.
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More Info Misc Details-Spinal Manipulation

Nature of Condition: Select condition from drop down list
Description: Type description
Additional Description: Type additional description
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More Info Misc Details-Mammography

Billing -> Patient Account -> New Charges Tab ->More Info
or
Billing->Patient Account->Claims tab->Select claim from list->More Info

The More Info dialog consists of several tabs for additional visit information needed by payers to 
process claims. Many specialties require specific dates, certification numbers, etc. Additional 
information can be added by clicking on the appropriate tabs. The information entered here will be 
at the claim level and will apply to all charges within the claim. Unless this additional information 
is required by the payer for your specialty, do not add any additional information.

For charge level only information, you can add information in the Charge Details by double 
clicking on a specific charge in New Charges tab or when editing charges in the patient Claims 
tab.
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More Info Misc Details-Mammography

Certification Number: Type Mammography certification number
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More Info Misc Details-Service Authorization Exemption

Billing -> Patient Account -> New Charges Tab ->More Info
or
Billing->Patient Account->Claims tab->Select claim from list->More Info

The More Info dialog consists of several tabs for additional visit information needed by payers to 
process claims. Many specialties require specific dates, certification numbers, etc. Additional 
information can be added by clicking on the appropriate tabs. The information entered here will be 
at the claim level and will apply to all charges within the claim. Unless this additional information 
is required by the payer for your specialty, do not add any additional information.

For charge level only information, you can add information in the Charge Details by double 
clicking on a specific charge in New Charges tab or when editing charges in the patient Claims 
tab.
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More Info Misc Details-Service Authorization Exemption

Code: Enter Exemption code, if applicable. 

Allowable values for this element are:
1 Immediate/Urgent Care
2 Services Rendered in a Retroactive Period
3 Emergency Care
4 Client has Temporary Medicaid
5 Request from County for Second Opinion to Determine if Recipient Can Work
6 Request for Override Pending
7 Special Handling
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More Info Misc Details-Investigational Device

Billing -> Patient Account -> New Charges Tab ->More Info
or
Billing->Patient Account->Claims tab->Select claim from list->More Info

The More Info dialog consists of several tabs for additional visit information needed by payers to 
process claims. Many specialties require specific dates, certification numbers, etc. Additional 
information can be added by clicking on the appropriate tabs. The information entered here will be 
at the claim level and will apply to all charges within the claim. Unless this additional information 
is required by the payer for your specialty, do not add any additional information.

For charge level only information, you can add information in the Charge Details by double 
clicking on a specific charge in New Charges tab or when editing charges in the patient Claims 
tab.
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More Info Misc Details-Investigational Device

Exemption Number: Enter exemption number.

Required when claim involves a Food and Drug Administration (FDA) assigned investigational 
device exemption (IDE) number. When more than one IDE applies, they must be split into 
separate claims.
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More Info Misc Details-Medical Record Number

Billing -> Patient Account -> New Charges Tab ->More Info
or
Billing->Patient Account->Claims tab->Select claim from list->More Info

The More Info dialog consists of several tabs for additional visit information needed by payers to 
process claims. Many specialties require specific dates, certification numbers, etc. Additional 
information can be added by clicking on the appropriate tabs. The information entered here will be 
at the claim level and will apply to all charges within the claim. Unless this additional information 
is required by the payer for your specialty, do not add any additional information.

For charge level only information, you can add information in the Charge Details by double 
clicking on a specific charge in New Charges tab or when editing charges in the patient Claims 
tab.
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More Info Misc Details-Medical Record Number

Number: Enter Medical Record number, if applicable.

Required when the provider needs to identify for future inquiries, the
actual medical record of the patient identified for this episode of care.
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More Info Misc Details-Anesthesia Related Procedures

Billing -> Patient Account -> New Charges Tab ->More Info
or
Billing->Patient Account->Claims tab->Select claim from list->More Info

The More Info dialog consists of several tabs for additional visit information needed by payers to 
process claims. Many specialties require specific dates, certification numbers, etc. Additional 
information can be added by clicking on the appropriate tabs. The information entered here will be 
at the claim level and will apply to all charges within the claim. Unless this additional information 
is required by the payer for your specialty, do not add any additional information.

For charge level only information, you can add information in the Charge Details by double 
clicking on a specific charge in New Charges tab or when editing charges in the patient Claims 
tab.
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More Info Misc Details-Anesthesia Related Procedures

Procedure 1: Click to open Select Charge dialog, and search for procedure code 1.
Procedure Code 2: Click to open Select Charge dialog, and search for procedure code 2.
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More Info Misc Details-Condition Information

Billing -> Patient Account -> New Charges Tab ->More Info
or
Billing->Patient Account->Claims tab->Select claim from list->More Info

The More Info dialog consists of several tabs for additional visit information needed by payers to 
process claims. Many specialties require specific dates, certification numbers, etc. Additional 
information can be added by clicking on the appropriate tabs. The information entered here will be 
at the claim level and will apply to all charges within the claim. Unless this additional information 
is required by the payer for your specialty, do not add any additional information.

For charge level only information, you can add information in the Charge Details by double 
clicking on a specific charge in New Charges tab or when editing charges in the patient Claims 
tab.
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More Info Misc Details-Condition Information

To supply information related to the delivery of health care

Required when condition information applies to the claim.
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More Info Misc Details-Demonstration Project

Billing -> Patient Account -> New Charges Tab ->More Info
or
Billing->Patient Account->Claims tab->Select claim from list->More Info

The More Info dialog consists of several tabs for additional visit information needed by payers to 
process claims. Many specialties require specific dates, certification numbers, etc. Additional 
information can be added by clicking on the appropriate tabs. The information entered here will be 
at the claim level and will apply to all charges within the claim. Unless this additional information 
is required by the payer for your specialty, do not add any additional information.

For charge level only information, you can add information in the Charge Details by double 
clicking on a specific charge in New Charges tab or when editing charges in the patient Claims 
tab.
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More Info Misc Details-Demonstration Project

Code qualifying the Reference Identification

Identifier: Enter Reference Identification Qualifier 

Required when it is necessary to identify claims which are atypical in
ways such as content, purpose, and/or payment, as could be the case for
a demonstration or other special project, or a clinical trial.
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More Info Misc Details-Care Plan Oversight

Billing -> Patient Account -> New Charges Tab ->More Info
or
Billing->Patient Account->Claims tab->Select claim from list->More Info

The More Info dialog consists of several tabs for additional visit information needed by payers to 
process claims. Many specialties require specific dates, certification numbers, etc. Additional 
information can be added by clicking on the appropriate tabs. The information entered here will be 
at the claim level and will apply to all charges within the claim. Unless this additional information 
is required by the payer for your specialty, do not add any additional information.

For charge level only information, you can add information in the Charge Details by double 
clicking on a specific charge in New Charges tab or when editing charges in the patient Claims 
tab.
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More Info Misc Details-Care Plan Oversight

Number: Enter number

Required when the physician is billing Medicare for Care Plan Oversight
(CPO).
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More Info Patient Tab-Claim Level

Billing -> Patient Account -> New Charges Tab ->More Info
or
Billing->Patient Account->Claims tab->Select claim from list->More Info

The More Info dialog consists of several tabs for additional visit information needed by payers to 
process claims. Many specialties require specific dates, certification numbers, etc. Additional 
information can be added by clicking on the appropriate tabs. The information entered here will be 
at the claim level and will apply to all charges within the claim. Unless this additional information 
is required by the payer for your specialty, do not add any additional information.

For charge level only information, you can add information in the Charge Details by double 
clicking on a specific charge in New Charges tab or when editing charges in the patient Claims 
tab.
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More Info Patient Tab

Required when patient is known to be deceased and the date of death is available to the provider 
billing system.
Date of Death: Enter date of death.

Required when claims involve Medicare Durable Medical Equipment Regional Carriers Certificate 
of Medical Necessity (DMERC CMN)
Weight: Enter Patients weight.

Required when mandated by law. The determination of pregnancy shall be completed in 
compliance with applicable law. The “Y” code indicates that the patient is pregnant. 
Pregnant: Place a check mark in box if Yes.
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More Info Property and Casualty Tab-Claim Level

Billing -> Patient Account -> New Charges Tab ->More Info
or
Billing->Patient Account->Claims tab->Select claim from list->More Info

The More Info dialog consists of several tabs for additional visit information needed by payers to 
process claims. Many specialties require specific dates, certification numbers, etc. Additional 
information can be added by clicking on the appropriate tabs. The information entered here will be 
at the claim level and will apply to all charges within the claim. Unless this additional information 
is required by the payer for your specialty, do not add any additional information.

For charge level only information, you can add information in the Charge Details by double 
clicking on a specific charge in New Charges tab or when editing charges in the patient Claims 
tab.
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More Info Property and Casualty Tab

Claim Number: This is a property and casualty payer-assigned claim number. Providers receive 
this number from the property and casualty payer during eligibility determinations or some other 
communication with that payer.

Contact Name: Required when the Subscriber contact is a person other than the person 
identified in the Subscriber Name.

Contact Phone: Required when this information is deemed necessary by the submitter.

Patient ID Type: Select Patient ID Type or Do not Send

Patient ID: Enter Patient ID 

First Contact Date: This is the date the patient first consulted the service provider for this 
condition. The date of first contact is the date the patient first consulted the provider by any means. 
It is not necessarily the Initial Treatment Date.

Service Facility
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Contact: Service Facility Contact Information
Phone: Service Facility Contact Phone
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More Info Providers Tab-Claim Level

Billing -> Patient Account -> New Charges Tab ->More Info
or
Billing->Patient Account->Claims tab->Select claim from list->More Info

The More Info dialog consists of several tabs for additional visit information needed by payers to 
process claims. Many specialties require specific dates, certification numbers, etc. Additional 
information can be added by clicking on the appropriate tabs. The information entered here will be 
at the claim level and will apply to all charges within the claim. Unless this additional information 
is required by the payer for your specialty, do not add any additional information.

For charge level only information, you can add information in the Charge Details by double 
clicking on a specific charge in New Charges tab or when editing charges in the patient Claims 
tab.
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More Info Providers Tab (Use only to override Default Info)

Use drop down options to overwrite existing Providers/Facilities at the Claim level. 

Rendering Provider-Select only if rendering provider is other than the provider indicated in the 
Owner field at the top. Otherwise, leave blank.  
Referring Provider-If a referring provider is set up in patient demographics, it will automatically 
default to the Referring Provider tab.
Primary Care Provider-Select from the drop down list only if required by patients insurance 
company for the services provided. Otherwise, leave blank.
Service Facility-Select from drop down list only if services are performed in a facility other than 
clinic's physical location indicated in Manage Groups setup. Otherwise, leave blank.
Supervising Provider-Select from the drop down list only if required by patients insurance 
company for the services provided. Otherwise, leave blank.

Accept Assignment-To change Accept Assignment to something other than default selected in 
Claims Options, select from the drop down list.
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More Info Referral/Authorization-Claim Level

Billing -> Patient Account -> New Charges Tab ->More Info
or
Billing->Patient Account->Claims tab->Select claim from list->More Info

The More Info dialog consists of several tabs for additional visit information needed by payers to 
process claims. Many specialties require specific dates, certification numbers, etc. Additional 
information can be added by clicking on the appropriate tabs. The information entered here will be 
at the claim level and will apply to all charges within the claim. Unless this additional information 
is required by the payer for your specialty, do not add any additional information.

For charge level only information, you can add information in the Charge Details by double 
clicking on a specific charge in New Charges tab or when editing charges in the patient Claims 
tab.
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More Info Referral/Prior Authorization Tab-Claim Level

Referral Numbers-Required when a referral number is assigned by the payer or Utilization 
Management Organization (UMO)
Prior Authorization-Required when an authorization number is assigned by the payer or UMO, 
and the services on this claim were preauthorized.

1. Click and type referral number below the Number column header.
2. Click on the drop down arrow and select primary, secondary or tertiary policy associated with 
the number.
3. Click Save.
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More Info Supplemental Information Tab-Claim Level

Billing -> Patient Account -> New Charges Tab ->More Info
or
Billing->Patient Account->Claims tab->Select claim from list->More Info

The More Info dialog consists of several tabs for additional visit information needed by payers to 
process claims. Many specialties require specific dates, certification numbers, etc. Additional 
information can be added by clicking on the appropriate tabs. The information entered here will be 
at the claim level and will apply to all charges within the claim. Unless this additional information 
is required by the payer for your specialty, do not add any additional information.

For charge level only information, you can add information in the Charge Details by double 
clicking on a specific charge in New Charges tab or when editing charges in the patient Claims 
tab.
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More Info Supplemental Information Tab

1. Control Number: Enter the control number
2. Report Type Code: Select from the drop down list.
3. Transmission Type: Select from the drop down list.
4. Click Save.

Required when there is a paper attachment following this claim.
OR
Required when attachments are sent electronically but are transmitted in another functional 
group rather than by paper. 
OR
Required when the provider deems it necessary to identify additional information that is being 
held at the provider’s office and is available upon request by the payer (or appropriate entity), 
but the information is not being submitted with the claim. 
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More Info Vision-Claim Level

Billing -> Patient Account -> New Charges Tab ->More Info
or
Billing->Patient Account->Claims tab->Select claim from list->More Info

The More Info dialog consists of several tabs for additional visit information needed by payers to 
process claims. Many specialties require specific dates, certification numbers, etc. Additional 
information can be added by clicking on the appropriate tabs. The information entered here will be 
at the claim level and will apply to all charges within the claim. Unless this additional information 
is required by the payer for your specialty, do not add any additional information.

For charge level only information, you can add information in the Charge Details by double 
clicking on a specific charge in New Charges tab or when editing charges in the patient Claims 
tab.
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More Info Vision Tab-Claim Level

Spectacle Lenses: Select Yes or No for applicable options.
Spectacle Frames: Select Yes or No for applicable options.
Contact Lenses: Select Yes or No for applicable options.
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More Visit Information Charge Level-Dialysis and DME

You can add additional information on a charge level by double clicking on the Procedure in Claim 
Details. This will open the Charge Details dialog. some of the tabs are duplicates of the ones 
seen in the More Info section, only at the charge level instead of the Claim level. There are other 
tabs that are not found in the More Info dialog because they are only used at the charge level. The 
tabs found in the charge level and in More Info should only be used for one or the other, but not 
both. Those will most often be required at the claim level and entered in the More Info section.
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Additional charge Information Dialysis Related

1. Double Click on a charge line item to open Charge Details. 
2. Click on tabs to add required information. These tabs will add information to each individual 
charge. 
3. Click Save. 

For information that will apply to all charges within the claim, see More Info. 
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Additional charge information DME (Durable Medical Equipment) Related

1. Double Click on a charge line item to open Charge Details. 
2. Click on tabs to add required information. These tabs will add information to each individual 
charge. 
3. Click Save. 

For information that will apply to all charges within the claim, see More Info. 



Practice Management 2012 User Manual  - 316

Additional Information-Charge Level Drug Tab

The NDC code can be added from the new charges tab, prior to posting a new visit to the patient 
ledger, or added from the Claims tab when editing an existing claim/visit. Double Click on a 
charge line item to open Charge Details, and enter additional information at the charge level.  
Click on the Drug tab.  

For information that will apply to all charges within the claim, see More Info. 
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Additional charge information Drug Related

Prescription Date-Required when a drug is billed for this line and a prescription was written (or 
otherwise communicated by the prescriber if not written).

Drug Code-The NDC number is used for reporting prescribed drugs and biologics when required 
by government regulation, or as deemed by the provider to enhance claim reporting or
adjudication processes. The NDC number is reported in the LIN segment of Loop ID-2410 only.
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The FDA issues their numbers in either a 9 or 10 digit format. CMS requires the number to 
be in the 11 digit format to be compliant with the new 5010 HIPAA standards. If the 
code you find on your vial is shorter in length (i.e., 9 or 10 digits), add one or more zeros to the 
code to create a longer code. A majority of them only have 10 digits.  
 
Here is where to place the extra zero:

• If the NDC code is formatted as 4-4-2, then the extra 0 goes in first position.  
####-####-## becomes 0####-####-##
• If the NDC code is formatted as 5-3-2, then the extra 0 goes in the 6th position.  
#####-###-## becomes #####0-###-##
• If the NDC code is formatted as 5-4-1, then the extra 0 goes in the 10th position.  
######-####-# becomes ######-####-0#

Drug Quantity-The dispensing quantity, based upon the unit of measure as defined by the 
National Drug Code.

Drug Unit-Code specifying the units in which a value is being expressed, or manner in which a 
measurement has been taken.

Prescription Number-Required when dispensing of the drug has been done with an assigned 
prescription number.
OR
Required when the provided medication involves the compounding of two or more drugs being 
reported and there is no prescription number.
 
1. In cases where a compound drug is being billed, the components of the compound will all 
have the same prescription number. Payers receiving the claim can relate all the components by 
matching the
prescription number.

2. For cases where the drug is provided without a prescription (for example, from a physician’s 
office), the value provided in this segment is a “link sequence number”. The link sequence 
number is a
provider assigned number that is unique to this claim. Its purpose is to enable the receiver to 
piece together the components of the compound.
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Add Description to NOC codes

New changes have been added to the Charge level for documentation of NOC NDC Codes.
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Additional Description for NOC Codes (Loop 2400 Segment SV101-7)

Additional Description - The 5010 professional claim transaction (837P) requires that when a 
non-specific or Not Otherwise Classified (NOC) procedure code is used (in the 2400/SV101-2), 
then a description is required in the 2400/SV101-7.  

Here’s the link to the NOC codes list from CMS: 
http://www.cms.gov/Medicare/Billing/ElectronicBillingEDITrans/Downloads/CMSNOCCodes.zip

Here’s the main link--once here you can scroll to the bottom to get to the zip file that has all 
the codes: http://www.cms.gov/Medicare/Billing/ElectronicBillingEDITrans/FFSEditing.html
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Additional Information Supporting Documentation-Charge Level

Add Supporting Documentation to charge, if applicable
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Additional charge information Supporting Documentation

Form Code-

Form Type Code-Required when adjudication is known to be impacted by one of the types
of supporting documentation (standardized paper forms) listed in LQ01.

1. Double Click on a charge line item to open Charge Details. 
2. Click on tabs to add required information. These tabs will add information to each individual 
charge. 
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3. Select from drop down listing.
4. Click Save. 

For information that will apply to all charges within the claim, see More Info. 
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Edit/Update Charges

Update/Edit Charges
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Edit/Update Charges 

Charges can be Corrected/Edited from several different locations within SOAPware Billing. This 
example shows a new charge in the New Charges Tab 

1. Double Click anywhere on the line item to Open the Charge Details dialog.

2. Click inside any editable field and make changes/corrections, as needed. 
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3. Click on any of the tabs to edit information for the selected charge.

4. Click the Save button to save changes

Edit Diagnosis Code

1. To add a Diagnosis Code, Click the Add Code button and begin Typing the ICD-9 code or Click 
in the Description search field and begin typing description. Click the Select button
2. Delete a code from the list by Clicking the X in front of the ICD-9 code
3. Change order of importance for diagnosis codes by Clicking on the Up and Down arrows to the 
right of the code description.  

Edit Modifiers

1. To add a Modifier, Click the Add Code button and begin Typing the Modifier code or Click in the 
Description search field and begin typing description. 
2. Click the Select button
3. Delete a Modifier from the list by Clicking the X in front of the Modifier
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Edit Procedure Codes

1. To change or add, Click to open the Select Charge dialog
2. Begin Typing the CPT code or Click inside the Description field and begin Typing a description 
for the Code and select code from the list
3. Click the Select button 
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Addendum added to Patient Chart when Visits are Edited in Billing

When a visit is created in a Patient Chart and has been edited in Billing, an Addendum is created 
and attached to the SOAP note section of the Patient Chart with a description of the changes
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Apply Payment to Patient Account in New Charges Tab

Apply Payment to New Charges 
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Apply Payment to charges in the New Charges Tab at Checkout. Payments should be applied 
prior to Posting new Charges to ledger. Payments can be applied to current charges and/or 
previous visits from the Make Payment dialog. After current Charges are edited and verified for 
accuracy, Click the Add Payment button to open Make Payment dialog.
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Apply Payment to New Charge

Payer Details Payer defaults to the Guarantor information, and can be edited to select a different 
payer

1. Payment Details Manual entry. Visits are inactivated until a Payment Amount is entered. Once 
an amount is typed into the field, the payment can be applied to the charges

Select method to apply Payment:

2. Disburse To automatically apply this payment, Click the Disburse button. This will post to the 
oldest outstanding charge in the patient account and continue with the next oldest account until 
the entire Payment amount is exhausted.  
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3. Pay All To apply payment to all outstanding charges on account at one time, Click the Pay All 
button. 

4. Pay Individual line item Charge To apply payment to current charge or selected charges, Click 
the Arrow in the Applied Column. The payment amount will automatically populate the field, and 
can be edited to spread the payment to other charges

Apply Payment to Visits/Charges

5. Apply Payment to Charges.This is a screenshot of one payment applied to two different 
charges. By Clicking on the arrows in the applied column, $50 was applied to each charge. As the 
Payment is applied, the Remaining amount is reduced by the applied amount.
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To make corrections, the Clear Applied button will remove current payments applied and reset the 
Amount.

6. Click Save to return to the New Charges Tab and Post transaction to patients Ledger

Change Payer

In the Make Payment dialog, Payer will Default to the Patient information. If someone other than 
the patient is remitting payment for the account, that information can be entered here for tracking 
payments/refund information, etc.

To remove the payer and add a new one, Click the X next to the Payer name. 
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Create a New Payer

Click + to add a new Payer or ... to search existing list of Payer/Non Patient accounts

New Payer details

Enter Payer details and then Click the Save button
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Add Payment Details

1. Enter Payment details including Payment method and amount of payment. As you type the 
payment amount, the lower portion listing the patient visits is activated. 

2.  If a Guarantor/Payer payment is to be applied to additional patients in the system, Click the Add 
Patient button or select a dependent from the Add Dependent list

3. Apply payment amount to several charges with one click. Payment will be applied to charges 
beginning with the oldest outstanding balance
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Apply Co-Pay/Pre-Pay to Visit

Apply Co-Pay/Pre-Pay to visit at check in

 When a Co-Pay is taken at the time a patient checks in, it will be saved in the Unapplied Co-Pay 
section in the New Charges Tab. The Screen shot in this step is how the New Charges Tab will 
appear at Checkout after the Visit has been posted to the New Charges tab from the Chart 
section. 

1. Click the Apply Co-Pay button to open Select Unapplied Co-Pay dialog.
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Select Unapplied Co-Pay

1. Select the Co-Pay from the list of Co-Pays to be applied, by clicking to highlight.

2. Click Ok

1. Select the visit to which the Co-Pay will be applied by clicking to highlight.

2. Double click on the arrow inside the Applied column to insert the co-pay amount. To undo any 
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applied amount before saving, simply double click again.

3. Click the Save button to save, or Cancel to exit without saving.

If the Disburse button is clicked, the Co-Pay will be disbursed to the oldest visit with a balance.

New Charges dialog opens. The Unapplied Co-Pay is zero, the payment is applied to the new 
charge and the Balance reflects the Payment.

4. Click the Post button to post transaction to the Patients Ledger.
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Delete Co-Pay From Patient Ledger

1. Click Ledger Tab.

2. Locate the payment line item and Click the X next to the Posted date.

3. Click Yes  to put the payment back into the Co-Pay Unapplied Amount and allow the user to 
reapply the Co-Pay to the correct visit/charge. 
No will remove the payment from the system. 
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Cancel will cancel the delete process and return to Ledger details.

Note: Only users with security privileges will be allow to delete a payment. 
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Delete a Co-Pay from visit 

1. Click Ledger Tab.

2. Locate the payment line item and Click the X next to the Posted date.

3. Click Yes  to put the payment back into the Co-Pay Unapplied Amount and allow the user to 
reapply the Co-Pay to the correct visit/charge. 

4. Click No to remove the payment from the system. 

5. Click  Cancel to cancel the delete process and return to Ledger details.

Note: Only users with security privileges will be allow to delete a payment. 
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Spread One Payment to Multiple Dependents

Pay multiple patient/dependent accounts from an Active Patient Account in the Make Payment 
dialog . Click on the Make Payment button found in several sections within the Patient Account. 

Select Dependents for Payment

If the Payer shown in the Payer Details section wants to pay additional patient/dependent 
accounts within the system, those payments can be applied from one dependent's account in the 
Make Payment dialog. If the Payer has dependents set up in the Family Tab, they will be in the 
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drop down Add Dependent list. If not, the patient can be accessed by Clicking the Add Patient 
button and selecting a patient from the Chart Rack.

1. Click the Drop down option to select another patient/dependent from the Payer's Family Tab.  

Apply Payment to Dependent(s)

This example shows a $100.00 Payment to be distributed between 2 Patient Accounts. The active 
patient will be listed first and the additional dependent(s) will be listed next.
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2. Click the arrow in the Applied column on the charge line item, and type payment amount for the 
first patient listed.

3. Repeat for the next patient listed. 

As payments are applied, the  Remaining amount is reduced until all has been distributed and 
then the remaining will be zero. The Clear Applied button will remove all applied amounts 
allowing corrections to be made prior to Saving the transaction

4. Click Save to return to the New Charges Tab and Post transaction to Ledger
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Patient Ledger



Practice Management 2012 User Manual  - 346

View Charges in Ledger

View charge details in patient account ledger
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Select a Charge to View

1. Double click on a Charge to view charge details
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Charge Details

2. View details for selected claim including Service dates, codes used when charging the service 
and miscellaneous

3. View additional claim information by clicking on the tabs
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4. Summary of Payments and Adjustments applied to selected Charge. You can open payment 
details by double clicking on the payment line
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Create a Claim from Ledger

If a claim has never been created for charges and insurance information is later added to patient 
demographics, create a claim from the patient ledger to submit to the payer.
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1. Open patient account and Click on the Ledger tab.
2. Click the Create Claim button to open Create Claim dialog.
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Select Charges to create a claim

3. Click to highlight and select the visit for which you wish to create a claim.
4. Click the drop down arrow to open listing of all insurance companies associated with the 
patient, including active or inactive policies. Click to highlight and select the payer responsible for 
the selected visit.
5. The Routing for the claim will default to the option selected in Insurance Companies setup. You 
can change that routing here if you prefer to print a paper claim instead of filing an electronic claim.
6. If you wish to open the Claims Manager after creating claim, place a check in the box.
7. Click Create button.

Claim(s) will be transferred to the Claims Manager Pending Scrub section to be scrubbed and 
then submitted to the payers.
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View Personal Payments in Ledger

View details of personal payments from the Patient Ledger
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Select a Payment to View

1. Hover the mouse over a Payment or Adjustment line for 2 seconds in the patient Ledger to view 
where the payment or adjustment was applied. 

2. Double click on a Payment line to view details of the transaction.  
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Payment Detail dialog opens showing all the details of the selected payment, including the 
charge to which the payment was applied.

2. Click the Close button
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View Insurance Payment Details from Ledger

View Insurance Payment Details from the Ledger Tab
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1. Double Click on the Insurance Payment line item.
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Insurance Payment details dialog opens listing all patient claims to which this payment was 
applied. 
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Print Receipt/Statement by date range from Ledger

Print a Receipt/Statement from the Patient Ledger Tab. Select by date or a date range. Select by 
Posted Date or Date of Service. This report can be Previewed and/or Printed
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1. Click the Print Receipt button
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Select Receipt From Date/To Date

2. Select a Date or Range of dates from the Print Receipt dialog.

3. Choose to generate the receipt by the date the transaction was Posted or by the Date of Service.

4. Click the Print button to open Print Preview
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Print Receipt/Statement

5. Click the printer icon to print or select one of the other options shown on the ribbon bar.
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Add Charges in Ledger

Add Custom Charges to patient account from within the Ledger Tab. Select Patient Account from 
Chart Rack and Click on the Ledger Tab

Note: Charges entered from the Ledger Tab will not be sent to the Claims Manager and 
submitted to Insurance. This option is for miscellaneous items unrelated to CPT or HCPCS 
charges
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Add Charges in Ledger Tab

1. Click the Add Charge button. Select Charge dialog opens
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2. Begin Typing Charge Code or Search by Code number or Description. Search includes 
Custom Charge Maintenance codes and CPT/HCPCS codes and must be included in the Default 
Fee Schedule to populate the Charge amount. 

3. Click the Select button to add charge to ledger

View Charge in Ledger

New Charge is added to ledger. If the Charge amount is blank, the code has not been setup in 
the default fee schedule amount. You can manually add the amount by Double Clicking on the 
line item and Typing the charge amount in the Charge Details dialog
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Add Payment in Patient Ledger



Practice Management 2012 User Manual  - 367

Apply Payment to Patient Ledger

1. Click the Add Payment button to open Make Payment dialog.
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2. Type payment details.

3. Apply payment to charges:
Disburse: Will auto disburse payment (older to most current charges).
Pay all: Will auto apply Amount to all outstanding charges.
Or you can manually apply payment to selected charge by clicking on the arrow in the Applied 
column (Red Arrow).
When entire amount is applied, Remaining balance will be $0.00

4. If receipt is requested place a check mark in the box next to Print Receipt and Click Save.

If errors are made, click Clear Applied to remove applied amount(s).
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Print Receipt for Payment in Ledger

Apply a personal payment from patient ledger and print a receipt. Receipt for payment now 
showing more details. For this lesson, we will apply a payment made by a Payer/Non-Patient to 
three separate dependents accounts from one dependent account.
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Apply Payment to multiple dependents from ledger

1. Click on Ledger tab in patient account.

2. Click on Add Payment.



Practice Management 2012 User Manual  - 371

Select multiple dependent accounts

3. Verify payer name.

4. Enter payment details.

5. Click Add Patient. Select dependent from chart rack and repeat for each dependent.
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Apply payment to each dependent visit

6. Click inside the grid in Applied column to apply payment to charge and repeat for each 
dependent account.
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Print a receipt for personal payment made in patient ledger

 When a payment is applied to an account from the ledger, the Print Receipt after Saving will be 
checked by default. If a printed receipt is not necessary, click inside the box and leave blank.
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Delete Personal Payment

Patient Account -> Ledger Tab

Open the Patient Ledger Tab and click the X on the payment line. You will be required to Confirm 
Delete. Yes will Delete and No will Cancel.

Note: Users must have security privileges to delete a payment.
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Delete an insurance payment from visit

Delete and reapply a previously posted insurance payment from the patient's ledger 
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Deleting an insurance payment from a patient visit

Prior to deleting payment, double click on the payment line and make note of the Claim number 
for reference.

1. Click the X next to the Post date for the payment that will be deleted.
2. Click Yes to continue deleting the payment, or No to cancel.
3. Close the patient account
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Select Remit to edit

4. Click Create/Load Payment to view list of open remits.
5. Click on the remit/post date containing the deleted claim.
6. Click Select to open the remit.
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Select Claim to edit

Note the Check amount and Remaining balance is showing as it was prior to Posting payment 
previously.

7. Click Select Patient button.
8. Enter Claim number.
9. Click Select to open payment details.
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View Payment details

View details of previously applied payment. 

10. Click to highlight Payment Amount and hit the delete key on your keyboard.
11. Click to highlight Provider Paid amount and hit the delete key on your keyboard.
12. Select Next Action for the claim. Note: If the claim was set to patient responsibility from 
previous posting, the claim status will remain as Processed, and patient will receive a statement 
on this charge, if there is a balance due. To prevent a statement from generating, you will need to 
select Refile, Wait for Additional Payment, File Secondary-Paper or Crossover-Pending 
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Secondary. This will change the claim status to Submitted, Pending Scrub or On Hold.
13. Click Save Claim
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Select correct Patient/Claim number to reapply payment

Note the remaining balance is the amount that was deleted.

15. Enter Claim/Patient account to reapply payment.
16. Click the Select button.
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Reapply payment to correct claim

17. Enter payment amount
18. Enter provider paid amount
19. Select Next Action for the claim 
20. Save Claim
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Print/Export Payment report and re post remit

Note the Remaining Balance is zero and the Post Payment button is activated for re posting. Also 
note that the original post date will remain and this is the date that will be reflected on the 
corrected patient's payment ledger

21.  Print or Export and Save payment posting report.
22. Click Post Payment. 

Until the remit is re posted, payments for each claim included in the remit will not appear on the 
patient ledger as paid.
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Add Adjustment in Ledger

Located in Billing -> Patient Account -> Ledger Tab



Practice Management 2012 User Manual  - 385

Add an Adjustment to Patient Account from the Ledger

Select Patient from the Chart Rack and Click on the Ledger Tab to View Account Details

1. Click the Add Adjustment button to Open the Select Adjustment dialog
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Select Adjustment Code

2. Access the list of Adjustment Codes and descriptions in Adjustment Maintenance by Clicking 
the Code or Description drop down arrow

3. Click to Select the applicable Adjustment in the list. This will activate the account details in the 
lower section 
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Apply Adjustment to Charge

4. Click the arrow on the line item to select charge to apply adjustment. The amount will default to 
the charge balance amount, but can be edited

5. Type Adjustment amount in field. 

6. Click the Okay button
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Refund Overpayment

Refund to Patient/Insurance 
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Patient Overpayment

1. Open patient account.
2. Click the Ledger tab to view credit.
3. Click th Add Adjustment button
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Select Adjustment Type

1. Click on the drop down for list of adjustments.
2. Select Refund from adjustment list.
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Apply Refund Amount

1. Double click to apply the amount of the refund. Amount will default to the amount of the
overpayment. You can also click inside the grid and manually type the refund amount. (Refund 
amount will be in parentheses) You will need to press the "-"/dash key before entering the amount 
to add the amount back to the account. For example the amount as shown in the screenshot 
would be entered as -200.00.
2. Click Save.
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Ledger view after refund 
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Payer/Non-Patient Accounts



Practice Management 2012 User Manual  - 394

Add a Payer/Non-Patient Account

Go to Billing -> Payer/Non-Patient Account

Create a New Payer/Guarantor

Click on Billing from the main menu and Click Payer/Non-Patient Account to open Non Patient 
Accounts Lookup.

1. Click on the Create New Payer icon.
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2. Complete payer information and Click Save.



Practice Management 2012 User Manual  - 396

Add Payer/Non-Patient Account in Demographics

Billing -> Patient Account -> Demographics Tab

1. Open Patient account and Click on the Demographics tab. 
2. Click Create a Non Patient Guarantor to open the New Payer dialog. 
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Enter Payer information and click Save. Guarantor/Payer name will populate the Guarantor field.
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Add Dependents to Payer Account

3. Click the arrow next to Guarantor name to open Guarantor Demographics.  

4. Click the Family Tab. The active patient will display in the Dependent list.

5. Click Add Dependent to add additional patients to this payer if needed. 
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Add Dependents to Payer/Non-Patient Account

Add Dependents to Payer Account

3. Click the arrow next to Guarantor name to open Guarantor Demographics.  

4. Click the Family Tab. The active patient will display in the Dependent list.

5. Click Add Dependent to add additional patients to this payer if needed. 
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Change Payer/Guarantor in Make Payment dialog

Billing -> Patient Account -> Ledger tab -> Add Payment or Billing -> Patient Account -> New 
Charges tab-> Add Payment 
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Add Payer from Patient Ledger

1. Click the Add Payment button to open Make Payment dialog.
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Payer name will default to Patient unless a Guarantor has been specified in Patient 
Demographics.

2. Click X next to current Payer name in Payer Details section of Make Payment Dialog. The field 
will be cleared.

3. Click button to select a different payer from Select Payer dialog.
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Enter Charges
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Enter Charges from Billing Menu

Billing -> Enter Charges
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Add a New Visit

Charges can be manually added by creating a New Visit from the New Charges Tab or they can 
be manually added to a visit/encounter posted from the Billing Statements Tab in the Patient 
Chart. This example will be Creating a New Visit

1. Click the New Visit button
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More Info-Owner Information for Manual Charge Entry

Manually posting visits in previous versions of SOAPware PM required clicking on More Info and 
adding the Owner and Facility for each visit. This will now default to automatically populate the 
Owner with the Active Provider . 

If the Rendering Provider of service is anyone other than the Active Provider, you can override this 
by clicking on the Providers tab and selecting that provider from the drop down list. If the rendering 
provider is the same as the active provider, leave this field blank.

http://soapware.screenstepslive.com/s/documentation/m/new_user_manual_current/l/24567-active-provider
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More Info-Facility Information for Manual Charge Entry

Manually posting visits in previous versions of SOAPware PM required clicking on More Info and 
adding the Owner and Facility for each visit. More Info->Facility will now automatically populate 
with the Active Facility selected in the Scheduler. For single facility users, the work flow will not 
change. If visits or charges are created for facilities outside the main facility (physical address 
indicated in Manage Groups), those facilities will still have to be selected in Providers 
tab->Service Facility.

1. Select Active Facility in Scheduler.
2. New Charges->More Info button is not alerting user that information is missing.
3. Claim Details->Facility is automatically populated with Active Facility.

http://soapware.screenstepslive.com/s/documentation_2012/m/new_PM_manual_current/l/52802-1-manage-facilities-block-24b-and-block-32
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Enter Charges from Billing Menu

6. Click the Add Charge button to Open the Select Charge dialog

7. Begin typing the Charge code in the box or Click inside the Description to Search the code data 
base. Click on the code from the list to insert it into the field 

8. Click on the Select button
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Add New Charge Details, including ICD-9/Diagnosis codes and Modifiers

Charge Details dialog will open for adding/editing New Charge. If a field is not grey/inavtivated, it 
can be edited for corrections or changes

9.  Click the Add Code button to Add a Diagnosis/ICD-9 code to the New Charge. Begin Typing the 
code or Click to search. When the correct code is in the field, Click the Select button or use the 
Enter key on the keyboard to select a Diagnosis. Repeat as needed
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10.  Type ICD 9 code or Search by description. 

11. To Add a Modifier to the New Charge, Click the Add Code button. Begin Typing the code or 
Click to search. When the correct code is in the field, Click the Select button or use the Enter key 
on the keyboard to select a Modifier and Enter again to add another code. Repeat as needed.

12. Check this box if this charge is not going to be submitted to insurance.  

13. Enter additional Charge information if applicable in the Misc Details section. The Facility field 
will be populated with the Facility selected in the More Info dialog. 

14. Click the Save button to save data. 

Repeat Steps 6-14 to add more charges
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Post New Charges to Patient Ledger

If patient has insurance primary and/or secondary  set up in Insurance demographics, those 
policies can be viewed in the lower section of the new charges tab, and the Follow Up Action will 
default to Submit to Insurance. This can be changed to  Do Not File-Patient Responsibility, if you 
do not want to send the charges to insurance.

The route for the primary insurance will default to the route specified in the Insurance Companies 
setup. If you want to change the route, you can do that at this time. 
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You can add a payment prior to posting charges, or apply a co-pay

15. Mark as Incomplete to save changes and come back at a later time to edit or post charges.
16. Enter any claim comments for internal use. (Will not print on claims)
17. Place a check mark to print a receipt, or leave blank.
18. Click the Post button to apply charges to the Patient Ledger and automatically Create a claim 
for the new charges.

The Patient  Ledger Tab will open and the New charge(s) will be shown in the ledger. 

Note: The insurance claim is created at this point. If any changes are made to the charge(s) while 
the claim is in the Pending Scrub section, and prior to uploading the claim to the payer, the claim 
must be placed into the On Hold section and rebuilt before the changes will be applied to the 
claim. Otherwise, it will be submitted the way it was at the time of posting and creating the claim.
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Enter Payments
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Add Personal Payments from Billing Menu

Main Menu -> Billing -> Enter Payments

Apply personal payments to patient accounts. Make Payment dialog can also be accessed in the 
New Charges tab and the patient account Ledger. To apply Insurance Payments to accounts, see 
Post Insurance Payments.

1. Click on the Enter Payments menu option to open the Chart Rack. Select a Patient from the 
Chart Rack and the Make Payment dialog will open.
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2. Type payment details.

3. Apply payment to charges:
Disburse: Will auto disburse payment (older to most current charges).
Pay all: Will auto apply Amount to all outstanding charges.
Or you can manually apply payment to selected charge by clicking on the arrow in the Applied 
column (Red Arrow).
When entire amount is applied, Remaining balance will be $0.00

4. If receipt is requested place a check mark in the box next to Print Receipt and Click Save.

If errors are made, click Clear Applied to remove applied amount(s).
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Claims Manager
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General Work flow-Claims Manager

Billing -> Claims Manager

 An Insurance Claim cannot be created unless insurance information has been entered in Patient 
Account Insurance Demographics tab. 
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 Paper claims are identified by the Icon in the first column. Electronic claims are blank. 

1. When a charge is posted to the Ledger from the New Charges tab, an insurance claim is 
created and inserted into the Pending Scrub section of the Claims Manager.

2. Claims are Scrubbed and placed in the Ready to Submit section. If the claim rejects for scrub 
errors, the claim will be placed in the On Hold section with a reason for rejection, and will need to 
be corrected.

3. After a claim is edited/corrected, it must be rebuilt to apply the changes, and scrubbed again. If 
a claim continues to reject when Scrubbed, this will have to be repeated until the claim is error 
free and moved to the Ready to Submit section.
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4. When the Claims are Ready to Submit, they can be generated and uploaded electronically, or 
printed on a CMS 1500 form.

Select a single Claim by Clicking the claim to highlight. To select random claims, Click on a 
Claim and while holding down the Ctrl key, left click on other claims to highlight. To Select all 
claims in a section, Click on the first claim to highlight and while holding down the Shift key, Click 
on the last claim to highlight those two and all the claims in between.

For details on setting up print options, please see Paper Claim Options.
 

Column Headers

Posted: Date Claim was posted to the patient ledger and claim was created
Claim: Claim number used for identification and tracking. This number is automatically assigned 
when the claim is created
Physician: Performing Provider 
Patient: Patient name
Primary: Identifies patients Primary Payer
PRT: Primary Payer Routing (Paper claim or Electronically sent)
Secondary: Identifies patients Secondary Payer
SRT: Secondary Payer Routing (Paper claim or Electronically sent)
Amount: Total amount of claim
File With: Filing claim with (Primary or Secondary)
Submission: Indicates to Payer if the claim is Original claim, Corrected claim, Replacement claim 
or a Voided claim
Status: Status of claim (On Hold, Pending Scrub or Ready to Submit)
Hold Notes: Hold notes gives a short explanation why the claim is being placed in the On Hold 
section. This note will automatically generate if the claim is rejected in the Scrub process. It can 
also be typed by clicking in the grid if the claim is manually placed on hold by user
Claim Notes: Claim  notes are automatically added when a claim is set to Refile, has been 
Rebuilt, etc.  It can also be typed by clicking in the grid if needed.  

Hold notes and Claim notes are for user reference only. Notes are not included on claims

http://soapware.screenstepslive.com/s/documentation/m/new_PM_manual_current/l/52805-4-setting-default-claim-options-base-export-path
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Enhanced Claims Manager

Quickly find a claim within the Claims Manager Working, Submitted or All tabs by Claim Number. 
Also view Total Claims in each section and  Total Amount for those claims.
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Search for Claim On Hold, Pending or Ready to Submit by Claim Number. View Total Claims in 
each section or tab, and Total Amount of claims

1. Locate a claim On Hold, Pending Scrub or Ready to submit by typing the claim number into 
the Find Claim By Number field. 

2. View total claims in each section or Tab, and total amount of claims.



Practice Management 2012 User Manual  - 422

Search for Claim in Submitted and All tabs by Claim Number and Post Date

To search for claims that have been submitted to payers, click the Submitted tab in the Claims 
Manager. (Claims in Submitted tab have been uploaded to payers, but not processed. Any claim 
created will be in the All tab, regardless of status).

1. Type the claim number into Find Claim by Number field.
2. Select date range the for the claim Posted Date.
3. Click the filter button.
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Pending Scrub

Claims will need to go through the Scrubbing process to check for missing data. This process 
will catch claims that are missing some basic information, such as insurance information, patient 
demographics, charge information, payer information, etc.

Pending Scrub Section

Patient accounts with payer information entered into the Insurance Demographics section of the 
Chart/Patient Account will automatically produce a claim when new charges are Posted to the 
Patient Ledger, and those claims will be placed in the Pending section of the Claims Manager. 
Claims can be selected for Scrubbing one at a time ,  selected claims or all claims. 

1. Click on the claim line to highlight.

To select random claims, Click on a Claim and while holding down the Ctrl key, left click on other 
claims to highlight. To Select all claims in a section, Click on the first claim to highlight and while 
holding down the Shift key, Click on the last claim to highlight those two and all the claims in 
between. This example shows all claims selected

2. Click the Scrub button. Claims will be moved to the Ready To Process section. If the scrubber 
finds an error on any claims, those claims will be moved to the On Hold section with a description 
of the error.

Note the Claim number 257 in the red box. This lesson will track that claim from Pending Scrub to 
Submitting claim.

Insurance remittance/response will use this claim number in the Patient Account section of the 
EOB to identify the patient.
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Scrub Errors

Claims will be moved to the Ready To Process section unless the scrubber finds error(s) on a 
claim as shown in this screen shot. Claims with errors will be moved to the On Hold section to be 
edited/corrected, with a description of the error as seen in this screen shot. 

3. Click Ok. The error dialog will continue to prompt you to click OK for each claim that has errors 
until all selected claims have been scrubbed.
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Scrubber Errors-How to Correct and Rebuild Claim

If the Scrubbing process finds a claim with errors/incomplete information, a Scrub Error message 
will pop up and the claim will automatically be moved to the On Hold section of Claims Manager. 

This lesson will describe the errors and list the steps to correct the error(s). The Claim will then 
have to be Rebuilt to apply the corrections, and Scrubbed again. When the claim has passed the 
scrubbing process, it will be automatically moved to the Ready to Submit section. 

Note: Edits/Corrections will not be applied to claims unless the Rebuild process is performed. 
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Scrub Errors 

Claim #841 was scrubbed and rejected because it was missing a diagnosis code for CPT code 
99215. 

1.  Click the OK button in the message box. 

2. In the On Hold section of the Claims Manager, Double Click anywhere on the claim line to open 
Patient Account. 

Patient account will open to the Claims tab with the active claim shown in the bottom section. 
Corrections can be made by clicking on any of the tabs, depending on what the scrub error 
indicates. 
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 After corrections are made, Close the Patient Account, return to Claims Manager and Rebuild 
claim to apply changes.
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At least one diagnosis must be entered for the charges: No Diagnosis entered for 99215

1. Double click on the line item that's missing info to open Charge Details dialog
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At least one diagnosis must be entered for the charges: No Diagnosis entered for 99215 
(continued)

2. Click Add Code in Diagnosis Codes section
3. Type code or use drop down to search by code or description
4. Click Select and Save 

Close patient account and return to Claims Manager. Select claim from On Hold section and click 
Rebuild.
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The Primary insured is missing part or all of their demographics 

Verify insured info 

1. Find the claim getting rejected in the On Hold section of Claims Manager and Double Click 
inside the grid to open Patient account. Click the Insurance tab. 
2. Click View next to the insurance company getting the error
3. Check each field in the Insured Information section and verify that it matches information 
exactly as it appears on insurance card, including the Patients relation to insured.

Return to Claims Manager and Rebuild claim to apply changes.
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Primary Insurance Company Missing Data

Check Insurance Company setup

1. Find the claim getting rejected in On Hold section of Claims Manager and find the Payer 
name-Primary column or Secondary column, depending on filing status
2. Go to Tools -> Insurance Company.
3. Find the Insurance Company/Payer within the list and Click the Edit Icon.
4. Add missing info.
5. Click OK

For step by step Insurance Company setup instructions, click here
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Return to Claims Manager and Rebuild claim to apply changes.

Secondary Insurance Company Missing Data

Check Insurance Company setup

1. Find the claim getting rejected in On Hold section of Claims Manager and find the Payer 
name-Primary column or Secondary column, depending on filing status Go to Tools  -> Insurance 
Company.
2. Find Insurance Company in Insurance Company Manager and Click the Edit Icon.
3. Add missing info.
4. Click OK
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For step by step Insurance Company setup instructions, click here

Return to Claims Manager and Rebuild claim to apply changes.



Practice Management 2012 User Manual  - 434

The line items are missing part or all of their detail-Units

Edit Charge Details

1. Find the claim getting rejected in On Hold section of Claims Manager and Double Click inside 
the Grid to open Patient Account.
2. From the Claims tab, click the claim getting the error to open it in Claim Details.
3. Double Click on the line item to open the Charge Details.
4. Add appropriate number of units in the field. 
5. Click Save. 
6. Repeat for each line item in Claim Details section.



Practice Management 2012 User Manual  - 435

Return to Claims Manager and Rebuild claim to apply changes.
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The line items are missing part or all of their detail-CPT/HCPCS Code

Edit Charge Details

1. Find the claim getting rejected in On Hold section of Claims Manager and Double Click inside 
the Grid to open Patient Account.
2. From the Claims tab, click the claim getting the error to open it in Claim Details.
3. Double Click on the line item to open the Charge Details.
4. Add appropriate code in the field. 
5. Click Save. 
6. Repeat for each line item in Claim Details section.
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Return to Claims Manager and Rebuild claim to apply changes.

The Provider is missing part or all of their information

Verify Rendering Provider information in Provider Manager

1. Find the claim getting rejected in the On Hold section of Claims Manager and Check for 
Provider name in the Provider column. 
 
2. Go to Tools  -> Provider Manager and verify correct info is entered in all fields. 

3. Add missing data.
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4. Verify Provider is linked to Billing/Group information.

5. Verify Signature is added.

6. Click Update. 

If there is not a Provider shown in the Provider Column, see next step



Practice Management 2012 User Manual  - 439

The Provider is missing part or all of their information-No Provider selected

1. Double Click on the line of the claim getting the error to open the Charge Details. 
2. From the Claim Details, double click on the claim getting the error  to open the Charge Details.
3. Use the drop down list to add the Rendering Provider in the Provider field.
4. Click Save.

Repeat for each line item in Claim Details.

Return to Claims Manager and Rebuild claim to apply changes.



Practice Management 2012 User Manual  - 440

The Referring provider is missing part or all of the information

Verify Referring Physician info is entered correctly in Contacts

1. Find the claim getting rejected in the On Hold section of Claims Manager and Double Click 
inside the grid to open Patient account. Click the Demographics tab. 
2. Check the name of the Referring Provider.
3. Go to Tools  -> Contacts and select the Referring Provider from the list. Double click to Edit 
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Contact Information.
4.  Verify Provider information is included in each required field.  
5. If additional provider IDs are required, add the insurance company requiring the ID and enter 
that information. 
6. Click OK to save information.

Return to Claims Manager and Rebuild claim to apply changes.

The Provider is missing all or part of the signature

Verify Rendering Provider Signature is loaded

1. Find the claim getting rejected in the On Hold section of Claims Manager and check the 
Physician column to find the name of the Rendering Physician.
2. Go to Tools -> Provider Manager and select that physician from the list of Providers.
3. Click on the Signature tab and make sure signature is selected. (See Provider Manager setup 
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in Billing Maintenance)
4. Click Update.

Return to Claims Manager and Rebuild claim to apply changes.
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The Facility is missing part or all of its address information

Verify POS/Place of service

1. Find the claim getting rejected in On Hold section of Claims Manager and Double Click inside 
the Grid to open Patient Account.
2. From the Claims tab, make sure the rejected claim is displayed in Claim Details and Double 
Click to open the Charge Details.
3. Add Facility. If Facility is already added, check the Facility Setup to verify information is correct.
4. Click Save.
5.  Repeat for each line item on the claim.
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Return to Claims Manager and Rebuild claim to apply changes.

The Facility is missing part or all of its information

Check Facility Setup 

1.  Find the claim getting rejected in On Hold section of Claims Manager and Double Click inside 
the Grid to open Patient Account.
2. From the Claims tab, make sure the rejected claim is displayed in Claim Details and Double 
Click to open the Charge Details.
3. Check the Facility in the Misc. Details section of Charge Details dialog as shown in the 
previous step.
4. Go to Tools -> Manage Facilities  and select the Facility from the list. 
5. Click the Edit icon.
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Facility Information

6. Verify required information is included in each field. (Include 9 digit Zip Code)
7. If Additional IDs are required, click the Additional IDs tab and enter required information.

7. Click Update to save changes. 

Return to Claims Manager and Rebuild claim to apply changes. 
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When auto accident is selected a state must be selected  

Add accident State and/or Date of Current to More Info dialog

1. Find the claim getting rejected in On Hold section of Claims Manager and Double Click inside 
the Grid to open Patient Account.
2. Verify the rejected claim is displayed in Claim Details (bottom section) of the Claims tab.
3. Click the More Info button.
4. Click on the drop down list and select State in which the accident occurred.
5. Click Save.

Return to Claims Manager and Rebuild claim to apply changes.
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Missing/Invalid Taxonomy Code

Verify Taxonomy Code in setup

In the On Hold section of the Claims Manager, find the claim with the error and check the 
Physician column to find the name of the Rendering Physician

1. Go to Tools ->  Insurance Companies.
2. Highlight the Insurance company rejecting the claim. 
3. Click  the Edit Insurance Company icon
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3. Click the Rendering/Performing Provider from the list in the Provider Setup section. 
4. Click the Edit icon to open the Edit Billing Information dialog.
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5. If the Group Taxonomy is missing, make sure the Legacy ID in the insurance Payment To 
section has Provider Taxonomy-ZZ and that the correct Taxonomy Code is entered.

6. For the Rendering Provider rejection, verify that the Legacy ID is Provider Taxonomy-ZZ and 
that the correct Taxonomy Code is entered in the Rendering Information section. For a list of 
Taxonomy Codes Click on  the link below.

http://www.wpc-edi.com/content/view/793/1

Return to Claims Manager and Rebuild claim to apply changes.

http://www.wpc-edi.com/content/view/793/1
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On Hold

Select Claim on Hold

After the Scrubbing Process, Claims that have error(s) will be placed in the On Hold section of the 
Claims Manager where they can be edited and then Scrubbed again for any further errors prior to 
Submitting to the Payer. This example lists three claims that are missing diagnosis codes.

1. Double click on the first claim to open the Claim Details in Patient Account. 
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Edit Claim

The Claim Details section allows access to all details of the claim in error to correct and Rebuild 
the claim before repeat the Scrubbing process. Note the Claim number in the screenshot is 257. 
A number is assigned to each claim as the claim is created for identification. That number can be 
found in the Claim ID column in the Claims Manager. Editing can be done by Clicking on the More 
Info button for claim information or by Double Clicking on the line of the Charge for charge/line 
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item corrections.

2. Double Click on the charge to access Charge Details 

Charge Details

The Charge Details dialog allows for editing most charge related errors. Fields can be edited by 
clicking on the drop down arrows or Clicking the buttons.
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3. Edit Procedure codes, dates of service, units or charges.
4. To add a Diagnosis code, Click the Add Code button.
5. Delete/Add Modifiers
6. Click on tabs to enter additional charge information
7.  Add misc. details
8. After making changes, click Save 

More Info

Tabs included in the More Info dialog allow for entering many specialty specific required items. 
For details, please see More Visit Information
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Rebuild Claims

After closing out of the Claims Tab, the Claims Manager will open. Repeat steps 5-8, or those 
steps applicable to the errors, until all claims you wish to correct/edit are completed.

9. Click to Select one or more corrected claim(s)

10. Click the Rebuild button. The claim(s) are moved to the Pending Scrub section to Scrub after 
corrections.
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Ready To Submit

Claims in the Claim Manager that have been scrubbed and are ready to submit to the Payer will 
be moved to the Ready to Process section

When claims have passed the Scrubbing Process, have no errors and are moved to the Ready to 
Submit section, they are ready to submit to the Payer. 

1. Select one or more claims to submit to Payer.

2. To submit only the Electronic claims in the Ready to Process section, Click the Generate 
Electronic button

3. To Print only the Paper Claims in the Ready to Process section, Click the Print Claims button

4. To submit some but not all claims, click to highlight the claims and then click the Submit 
Selected button.

Note: To automatically upload claims to Gateway EDI, you must have the required information 
setup in Claims Options .
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Printing CMS 1500 Claims using Plain paper

To print claims using plain paper, place a check mark in the Print Full CMS Form box. Using a 
color printer will print the lines and blocks shaded in red. Printing with black ink only will print the 
form in black and white.
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Printing CMS 1500 Claims using Preprinted forms

If using preprinted CMS1500 forms, remove the check mark from Print Full CMS Form box. This 
will just print the text into the fields.

Please Note:

Most printer manufacturers install a PCL (Printer Command Language) driver by default. This 
works well if printing documents in just plain text and with very little formatting, for example a word 
document on a home computer. However with the complexity of forms and page layouts, it is 
recommend, printing these documents on a PS (Post Script) Print Driver instead of a PCL driver. 
This type of printer driver will handle the forms information most efficiently. SOAPware 
recommends using any business grade printer, or a color laser jet printer, if selecting Print Full 
CMS Form.

Note: Selecting Print Full CMS Form will print the front of the CMS 1500 only, and will not include 
the print on the back of the form. If a payer requires the standard front and back of the CMS 1500 
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form, the claim will not be acceptable.

SOAPware does not support printers/scanners. Meaning that SOAPware does not install printer 
drivers or set printer configurations. Please contact an IT person for additional hardware matters. 
However, it is recommend to download the most recent printer drivers needed from the 
manufacturer's website. It is usually a FREE DOWNLOAD. If there is trouble locating the driver 
needed, please contact the manufacturer directly. Be cautious of downloading drives from an 
alternate source other than the printer manufacturer. 

Thank you,
SOAPware Support
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Submitted Tab

The Submitted Tab lists all claims that have been submitted to Payers. Claims can be searched 
by Date Range and the information listed in the columns can be sorted by clicking on the column 
headers. 
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Claims Manager: Submitted Tab

1. Select a submitted date range
2. Click on the filter button
3. Double click on a claim to open the claim for editing
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Resubmit Claims Rejected by Clearinghouse

Billing -> Claims Manager -> Submitted Tab

Edit and resubmit claims that have been rejected by the Clearinghouse. 

Select Claim for Correction

1. Click the Submitted tab, double click a claim to open Claims tab in Patient Account..
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Edit Claim

1. If rejection is for Visit information, click the More Info button. 

2. If rejection is connected to Charge details, double click the line item in Charges section of the 
Claims tab.

For additional instructions on making corrections to claims, please see On Hold lesson
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Rebuild Claims

6. After all claims have been edited/corrected, Click the Rebuild button for each to apply changes 
to the claim.  

This process will automatically move the claim to the Pending Scrub section in the Working tab.
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Scrub Corrected Claims

7. Click to highlight the corrected claims.

8. Click Scrub.
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Submit Corrected Claims

9. Click to highlight Corrected claims.

10. Click Submit Selected. To submit all claims in Ready To Submit section, just click the 
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Generate Electronic button. 

Note: To correct and resubmit a claim that has been rejected by the Payer, see Resubmit 
Claims Rejected by Payer/Insurance Company.
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Resubmit Claims Rejected by Payer/Insurance Company

Resubmit a claim that has been rejected by the payer/insurance company. This requires the 
Claim Frequency Type Code or Submission Type be changed from Original to another type, and 
must include an original reference number or ICN.

Billing->Patient Account->Claims tab/Insurance tab/Demographics tab
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Open patient account to make corrections prior to rebuilding and resubmitting claim

After making corrections to rejected claim, click on the Claims tab. If the claim is rejected for 
charge details, corrections can be made while adding the ICN/Original Reference number

1. Find the rejected claim in the Claims list and click to highlight line item and open in Claim 
Details section. 
2. Click the box next to On Hold to move the claim to the On Hold section in the Claims Manager.
3. Click More Info button to Edit Claim Details.
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Add Original Reference Number/ICN In Misc Details tab

1. Number: Enter ICN/Original Reference Number as shown on explanation of benefits or 
rejection report.
2. Policy ID: Select payer from drop down list. This list is pulled from the insurance policy 
information in patient Insurance demographics.
3. Click Save.
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Change Claim Frequency Type/Submission Code

4. Rebuild claim.
5. Click to display drop down list
6. Select Replacement for professional claims, Corrected for  institutional claims, Void to submit 
a voided claim.

These codes are associated with the Claim Frequency type and are indicated in the electronic file:

Original-1
Corrected-6 (Select for corrected Institutional claims)
Replacement-7 (Select for corrected Professional claims)
Void-8

7. Scrub claim to move it to the Ready to Submit section to be resubmitted to payer.
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Rebuild Multiple Claims at one time

Rebuild an entire claim file or multiple claims at one time to resubmit to payers. 
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Rebuild Selected Claims

1. Click on the Submitted tab.

2. Select Filter Posted Date range.

3. Select claims by Clicking on the first one and while holding down the Shift key Click on the last 
claim. This will highlight those claims and all claims in between. Or hold down the Ctrl key and 
select multiple claims one at a time.

4. Click the drop down arrow next to Rebuild Selected button and add a note for rebuild reason, if 
needed. The comment will display in claim details for reference. 

5. Click Rebuild Selected button.
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6. You will be prompted to confirm rebuilding the number of claims selected. Click Yes to continue 
or No to cancel. Claims will be transferred to the Pending Scrub section in the Working tab.
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Scrub and Submit Rebuilt claims

7. Select claims to scrub and Click Scrub.

8.  Select claims to Submit and Click Submit Selected, or to submit all claims in the Ready to 
Submit section, click Generate Electronic.
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Refile a Claim

Refile a Claim from Submitted Tab

Claims can be refiled or placed on hold from the Submitted Tab within the Claims Manager

1. Double Click on the claim to open Claim Details dialog. Follow the steps to edit claims as 
instructed in the On Hold lesson. 

2. After editing claim, click the Rebuild button to open Rebuild notes dialog. Type notes pertaining 
to the refile, if applicable.

3. Click on the Rebuild button within the notes dialog. Changes will be added to claim and the 
claim will be placed in the Pending Scrub section of the Claims Manager.

Claim Notes will reflect the date the claim was rebuilt and any notes. Rebuilt claim is ready to be 
Scrubbed and Submitted to Payer. See Scrubbing Claims and Ready to Submit
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Omit a paid charge when refiling from Insurance Payment Posting

Omit a paid procedure from a claim when resubmitting unpaid charges to insurance.

Billing -> Post Insurance Payments
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Refile only denied charges to Insurance

1. Comment Reason for denial 

2. Apply payment amount to paid charge(s).

3. Set Next Action to Refile.

4. Double Click on line of paid charge(s) to open Charge Details.
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Omit Paid Charges

5. Place a check mark to Omit from Claim. Click Save.
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Post Payment to ledger

Check mark will be placed in the Omit column. When claim is Rebuilt, this charge will not be 
refiled to insurance.

6. Select Route for refiling claim (Paper or Electronic) 
7. Select the File With from drop down option
8. Save Claim and then Post Payment to ledger. Claim will move to On Hold section of Claims 
Manager.
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Rebuild Claim

Go to Billing -> Claims Manager

9.   Locate claim in On Hold section

10.   Rebuild Claim to save claim changes and Scrub claim

Claim is now Ready to Submit
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Secondary Claims

When posting a primary insurance payment to a patient visit/claim that has a secondary 
insurance policy set up in Insurance Demographics, the Next Action will default to File 
Secondary-Paper. 

Secondary claims will automatically be moved to the On Hold section in the Claims Manager once 
the primary insurance payment is applied to the visit and File Secondary-paper is selected for the 
Next Action.

Set Secondary Claims to process

1. When posting primary insurance to a visit, verify the Next Action selected is  File 
Secondary-Paper. 
2. Save Claim.

When the entire remit is applied to charges and Posted, the secondary claims will be located in 
the On Hold section and  ready to process in the Claims Manager.
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Rebuild Secondary Claim

3. Locate the secondary claim. Click to highlight. 
4. Click Rebuild. Claim is moved to Pending Scrub section.
5. Click the Scrub button. Claim is moved to Ready to Submit.  

Scrub Secondary Claim

5. Click the Scrub button. Claim is moved to Ready to Submit.  
 
Note: Paper claims can be previewed by clicking on the PDF icon in the Pending Scrub section
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Print Secondary Claim

6. Click the Print Claims button. All paper claims in the Ready to Submit section will print.

7. Click to highlight a single claim and then click the Submit Selected button. Only the highlighted 
claim will print. 
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All Tab

The All Tab lists all claims in the Working and Submitted tabs and the current status of the claim. 
Claims can be searched by Date Range and the information listed in the columns can be sorted 
by clicking on the column headers. 
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Posting Insurance Payments
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Introduction to Insurance Payment Posting
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Introduction to Insurance Payment Posting 

Create/Load Payment Detail is manually entered using information from the Remittance/EOB.
 
Patient Details Displays patient information from the General Demographics section and 
Patient/Family Balances from the Patient Ledger

Claims Lists Outstanding/Unpaid insurance claims for the Patient, the status of the Claim and 
details pertaining to the claim. To include paid claims in the list, place a check mark in the box 
next to Show All Claims

Claim Details Populated with information pertaining to the claim. Payment information is manually 
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added with information from the remit/EOB

Charges Breaks down the individual charges/services that are included in the selected visit/claim. 
Double Click on a line item to view Charge Details
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Select Claim/Visit for Payment

Outstanding claims are listed in the Claims section of the Posting window. If a claim is 
highlighted, the lower section of the window displays each line item/charge that makes up the 
selected claim. Details in both the Claims and Charges sections can be sorted by Clicking on the 
column headers. 

1. Click inside the Claim grid to select a claim for payment.
 
2. Details of the selected claim will display in the Charges section of the window.
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Enter Claim Details using Remit/EOB

The Claim Details section displays various details entered when charging the selected claim, 
including miscellaneous accident/illness info. This information cannot be edited.  Payment 
information is entered using details from the Insurance Remittance.

3.  Type Total Payment amount for the selected claim. An alert will show if an amount more than 
the remaining amount of the check is entered

4. Type Claim Control number from Remit for informational/tracking purposes

5. Enter total amount that is the responsibility of the insured/patient as shown on Remit
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Apply Payment to Charges

The payment is ready to be applied to the charges. Note that the Remaining Balance amount is 
the same as the Payment Amount and will decrease as payments are applied to the line items. 
When the last payment is applied to the final charge, the Remaining Balance should be zero.

6. Match the remit payment to the correct charge by verifying Begin and End dates, Procedure 
code and Amount Billed.

7. Click on the line of the charge inside the Allowed Column and enter the amount shown on the 
EOB as the Allowed amount.

8. Tab to the next column and enter any amount that was applied to the deductible, CoInsurance, 
etc. 

9. Enter the contractual adjustment amount in Other Adjustment column, and Payment amount in 
Provider Paid column.  If payment is zero, you must populate one of the other fields (Allowed, 
Deduct, etc.) in order to activate the Save Claim button.  Repeat until the remaining Balance is 
zero, all charges for the selected claim have the correct information applied and the Save Claim 
button is activated.

10. Verify the  Next Action. This will determine whether a secondary claim is generated, If the 
Primary insurance crossed the claim over to the Secondary payer, and no secondary claim is 
needed, or if the balance is patient responsibility. 
Patient Responsibility: Claim status will change to Processed and the balance for this visit will be 
moved to patient responsibility.
Crossover-Pending Secondary: A secondary paper claim will not be generated and the balance 
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will remain showing as pending insurance payment.
File Secondary-Paper: A secondary paper claim will be generated and placed in the On Hold 
section of the Claims Manager ready to Rebuild, Scrub and Print.
Refile: If claim is partially paid and you need to refile any unpaid charges, this option will place the 
claim in the On Hold section of the Claims Manager ready to Rebuild, Scrub and Print.
Wait for Additional Payment: Claim will remain in the insurance pending status until additional 
payment is applied.

11. Click Save Claim.  A pop up message will verify payment was saved. Click OK.

If Cancel is clicked, a confirmation box asks if you want to close the Patient and lose changes. If 
Yes, the patient window will cancel all data entered for the active patient and close the account If 
an amount is remaining on the remit, Select Patient dialog displays to choose a new patient. 

Note: A payment can be edited after a claim is saved and posted as needed. 
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Post Insurance Payment to Patient Ledger

If the Insurance EOB is for a single patient payment, and the Remaining Balance in the upper 
section/Remit details is zero, the Remit/EOB will need to be posted to the patient ledger and 
closed. If the Remit/EOB is for multiple patients/payments, you will be prompted to select another 
patient and will repeat the previous steps until the entire check is applied.

1. Print Payment (optional). generate a report to verify all payments and how they were applied for 
the active remit/check. Make any corrections/edits prior to Posting to remit.

2. Click the Post Payment button to Apply payment(s) to Patient Ledger. Payment will not be 
reflected in Patient ledger until it is Posted
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Note: The payment(s) will be included on the End of Day report for the Date Posted. If the Date 
Posted is a different month than the Check Date/Date Entered, the ledger and month end 
reporting will be reported by the Post date. The Payment Posting date cannot be changed.
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Create Insurance Payment

Access from the main menu ->  Billing -> Post Insurance Payments

Select Payer/Insurance Company from Drop Down list of existing Payers in the Insurance 
Company Maintenance

1. Use Drop Down to Select a Payer from the list

2. Type Check number shown on the Remit

3. Click the Create button
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Add Remit Information as shown on EOB

4. Select Billing Provider/Pay to Information from the drop down list in the Group Section

5. Enter Production date. This is for internal use and will not be used for any reporting date. It can 
be the check date, date entered, etc.

6. Type date of receipt/deposit. This is the date that will be used to run the Payment Summary and 
help in balancing deposits for the day. 

Note: When applying insurance remits that are deposited on a specific day, but not entered into 
Insurance Payment Posting until a later date, the Check Date can be back dated to the date of 
deposit so it will print on the Payment Summary for that date, for use in balancing out the days 
deposits. This example is a remit received and deposited on 4/8/2010, but not entered and 
applied to visits until 4/14/2010.

The payment(s) will be included on the End of Day report for the Date Posted. If the Date Posted 
is in a different month than the Check Date/Date Entered, the ledger and month end reporting will 
be reported by the Post date. The Payment Posting date cannot be changed.

7. Type Check amount shown on the check

8. Click the Select Patient button
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Select the Patient account for Payment

9. Type the Patient account number shown on the Remit or Click on the Chart Rack button to 
search for the Patient.

10. Click Select to Open the Patient account
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View of Payment Posting window with Patient Selected for Payment

When selecting a patient, the account number shown on the remit is the Claim number assigned 
to the visit. When patient is opened, the grid will go directly to the claim number that was entered.

After all payments have been applied and the Remaining amount is zero, the Print Payment 
button will create a report listing payments applied for reference. The report can be displayed or 
printed, or can be exported and saved to a file on your computer. 

Refer to next lesson for applying payments to visits. Introduction to Insurance Payment Posting
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Reports
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Accessing the Report List

Billing menu -> Reports

Accessing the Report List

1. Click on the Billing menu. 
2. Select Reports.
3. Select the report needed.
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CPT® Master Report

A report showing all CPT codes in the database for a specified year or all years combined.

CPT Master Options

1. Select the year of the CPT codes or check to see All Years ' codes. 
2. Select to sort by either the code or the description and the code.
3. Click Ok.
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CPT Master Sample

Sample CPT Master Report for the year 2010, sorted by Code.



Practice Management 2012 User Manual  - 503

HCPCS Master Report 

A report showing all HCPCS codes in the database for a specified year or all years combined.

HCPCS Master Options

1. Select the year of the HCPCS codes or check to see All Years ' codes. 
2. Select to sort by either the code or the description and the code.
3. Click Ok.
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HCPCS Master Sample

Sample HCPCS Master Report for the year 2010, sorted by Code.
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ICD Master Report  

A report showing all ICD codes in the database for a specified year or all years combined.

ICD Master Options

1. Select the year of the CPT codes or check to see All Years ' codes. 
2. Select to sort by either the code or the description and the code.
3. Click Ok.
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ICD Master Sample

Sample ICD Master Report for the year 2010, sorted by Code.



Practice Management 2012 User Manual  - 507

Custom Charges Master Report   

A report showing all custom codes in the database.

Custom Charges Master Options

1. Check if you want to show all active codes. 
2. Select to sort by either the code or the description and the code.
3. Click Ok.

Custom Charges Master Sample

Sample Custom Charges Master Report with only active codes showing.
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Adjustment Code Master Report   

A report showing all adjustment codes in the database.

Adjustment Master Options

1. Check if you want to show all active codes. 
2. Select to sort by either the code or the description and the code.
3. Click Ok.

Adjustment Code Master Sample

Sample Adjustment Code Master Report with only active codes showing.
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Fee Schedule Report  

A report showing the fees set for each code, according to the selected Fee Schedule.

Fee Schedule Report Options

1. Select the desired fee schedule from the drop down. 
2. Click Ok.

Fee Schedule Report Sample

Sample Fee Schedule Report for the Default fee schedule.
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Dependency Report  

A report showing the fee schedules that have dependencies on them, and the percentage that is 
being calculated for each.

Dependency Report Sample

1. The base Fee Schedule. The fee schedule(s) listed below are based on the top fee schedule.
2. The calculated fee schedule, based on a percentage of the above fee schedule.
3. The percentage of #1 fee schedule to calculate the #2 fee schedule.
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Duplicate Report

A report showing any duplicate patients in the database. Searchable by First, Middle or Last 
Name, SSN, Date of Birth, or Phone Number. 

Patient Duplicate Options

Search by any of the above criteria to find duplicate patients. 

Patient Duplicate Sample

Sample Patient Duplicate Report searching by last name, Slim.
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Payment Summary Report 

A report for showing the payments by payment type that have been entered during a specified time 
period.

Payment Summary Report Options

1. Start Date and End Date: Select a date range in which to see all of the payments entered.

2. User: If wanting to run the Payment summary for a particular user, select the appropriate user 
from the drop down. 

3. Exclude Posted Only: Posted Only refers to payments that were only officially posted on the 
current date, but have a different (previous) Entered Date. This situation would occur if you took a 
pre-payment for a patient, but did not officially post the payment to their account that day (and it 
remained in the patient's Pre-Pay bank), but you did deposit the check at the bank. On the day that 
you do post those charges to the patient's account, if you do not want that payment on your 
payment summary report (because it has already been deposited), you can check the Exclude 
Posted Only box. If you would like to see those items on your Payment summary, if you leave the 
Exclude Posted Only check box UNchecked, you will see those items listed as Posted in their 
status. In addition, you will be able to see both the Entered Date and the Posted Date, should any 
confusion arise.

4. Group by User: Checking this box will show payments entered by user (unless a specific user 
has been selected already).
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Payment Summary Sample for all Users

1. The Date Range for the Payment Summary data.

2. Date Run: The date the report is generated

3. Indicates how the report is run: By User or All Users

4, 5 & 6:  Payment Types : Cash, Check, Credit Card, Insurance payment, etc.

7. Payment Status (Posted): Indicates that the payment was officially posted to the patient's ledger 
during the date range specified. Refer to the Date Posted column for the item to see the specific 
post date. This status will have both an Entered Date and a Posted Date. Depending on the 
circumstances, in some cases, these 2 dates may not be the same.

8. Payment Status (Unapplied): Indicates any payments that were taken from the patient and 
entered, but not officially applied toward any charges. (Will pertain to Co-Pays and Pre-Pays). This 
status will show an Entered Date, but no Posted Date.



Practice Management 2012 User Manual  - 514

9. Payment Status (Nonposted): Indicates any payments that have been entered into the system, 
applied to charges, but have not been posted to the patient's ledger. These payments will be 
found in the patient's New Charges tab of their patient account. This status will show an Entered 
Date, but no Posted Date.

10. Date Entered: The date that the payment was entered and saved for a particular patient. 

11. Date Posted: The date that the payment was posted to the patient's ledger. 

12. Type: Indicates the type of payment (will be a Co-Pay, Pre-Pay, or Payment).

13. Patient Name: The patient to whom the payment was saved. 

14. Account No.: The account number for the patient indicated.

15. Reference Number: Will indicate any information that was typed in as a reference for the 
payment when it was taken. (Could be a check number, credit card type, etc.) 

16. Amount: The amount of the payment that was stored for the patient indicated. 
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Production by Procedure Report (by Provider, Referring Provider and/or Facility)

A report for showing the production by code for a specified date range and searchable by Provider, 
Referring Provider, and/or Facility.

Production by Procedure report will include all charges applied to a Visit in the New Charges tab, 
even if they have not been posted to the Patient ledger. If you are finding discrepancies between 
this report and the Month or Year end reporting, we recommend running the Missing Charges 
Report to check for any Visits that have not been posted to the Patient account.

The Amount for each Procedure listed is the amount indicated for the code in the Default Fee 
Schedule. Total Amount Billed will depend on the number of Procedures charged, and any 
amount that is overridden in the Charge section of Charge Details. 

Production by Procedure Report Options

Search for payments entered by Date Range, Provider, Referring Provider, and/or Facility. To 
report all Providers and Facilities, leave blank.
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Payment Summary Sample

Sample Production by Procedure Report searching by date range and selecting all providers.
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Statement Report  

This Statement manager allows statements to be run both in group or individually by patient or 
guarantor. 

Billing menu->Reports->Statement Report

Statement Report Options

1. Minimum Balance: Set a minimum balance by which to send statements out. This will not 
allow any statement to print if the balance is less than the minimal set here.

2. Group: Print batch statements by Provider or Group.
3. Patient: Print individual statements for a select Patient.
4. Guarantor: Print individual statements by a select Guarantor.
5. Date Range: Select for aging on statements to calculate based on the Date of Service or the 

Posted Date of each charge.
6. Search Guarantor: Run batch statements alphabetically by Guarantor/Patient Last Name 

Range. (Statements will be grouped by Guarantor.)
7. Remit To: Select the Remit To facility for receiving patient payments.
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8. Notes: Enter any note that you would like to go on every statement within the batch selected.
9. Do not show tax id: Check to not include the Tax ID on patient statements.
10. Do not show pending insurance items: Check to NOT include any charges that are pending 

insurance.
11. Top Margin: If using any kind of perforated paper to send out patient statements and need to 

adjust the margins, enter the number that matches up with your statement paper.
12. Submit Via Clearinghouse: If sending statements to Gateway EDI for them to print out and 

mail for you, check this box to upload the statement batch.
13. Testing: If needing to send a test batch of statements to Gateway EDI, check this box prior to 

sending.
14. Click Okay when finished to generate the statement batch.

*Note:  If a patient has a personal balance but is not included in the statement batch, verify that the 
Do Not Send Statements check box  is not selected.  This is located under the Statements tab in 
the patient's account.
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Sample Statement

  For the best fit, use the #9  (3 1/8 in x 8 7/8 in) double window envelope.

Confirm Saving to the Database

Click Yes  to save a copy of each statement in the associated patient account.
Click No to not save a copy of each statement in the associated patient account, and re-run the 
statement batch.
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Credit Balance Report  

A report showing all patients with credits on their accounts.

Credit Report Sample

Sample Credit Report 
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Missed Charges Report 

A report showing any possibly missed charges within SOAPware, by Provider.  Filter report by 
Start date. The report will display 3 specific areas where charges could be being missed: 

1. Encounters: Any patients with encounters that do not have an associated billing statement 
will be shown.

2. Superbills: Any patients with superbills that have never been posted will be shown. 
3. Visits: Any patients with visits that are in the patient's New Charges tab of their Patient 

Account that have not been posted to the patient ledger will be shown.

(Previously known as SOAP Audit Report)

Missed Charges Report Options

1. Select the Provider from the drop down. 
2. Select a Start Date.
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Missed Charges Report Sample showing Encounters without a Superbill

1. Encounters with no Superbill created. Will indicate Encounter Date, Patient Name, Account 
Number, and the associated reason for the visit (Encounter Name).
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Missed Charges Report Sample showing Non-Posted Superbills and Visits

2.  Superbills that have not been posted. Will indicate Superbill Date of Creation, associated 
Patient Name and Account Number.

3.  Missed Visits found in the New Charges tab of the patient account. Will indicate the Visit Date, 
associated Patient Name and Account number.



Practice Management 2012 User Manual  - 524

A/R Patient Report  

A report showing all patient A/R, searchable by selecting a specific Guarantor or Patient, Patient 
Account Number, and Filtered by either Patient or Insurance amount or Both. Also filterable by 
Aging Category of Current, 30, 60, 90, 120 days or All, as well as setting a particular dollar range 
for the Type or Aging. 

A/R Patient Report Options

1. Create an A/R Patient report for a particular Guarantor.* 

2. Create an A/R Patient Report for a selected Patient. *

3. Create an A/R Patient Report for a particular patient, by entering their Account Number.*

4. Filter your report by any or all of the below options. These categories build on one another. The 
range at the bottom will search based on the specific options that are selected in both Type and 
Aging.  

    Type - Patient, Insurance, Both: Select one of these options to filter. Filter just the Patient 
balance or the Insurance balance or Both together. 
    Aging - Current, 30 Days, 60 Days, 90 Days, 120 Days, All: Select an aging category to filter.
    Balance Range Start and End: The amount range entered here will apply to the options 
selected in Type and Aging. For example, if you wanted to filter for any Insurance balance that has 
been outstanding for 120+ days that is greater than $1,000, you would select Insurance for Type, 
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120 Days for Aging and enter 1,000 for the Balance Range Start.
    NOTE: You MUST have a Start and End Balance entered to run the report. 

5. Click Okay when finished.  

* If these fields are left blank, the report engine will search the entire patient database, based on 
the criteria entered at the bottom.

A/R Patient Report Sample

1. Each patient shown will indicate the Patient A/R breakdown with totals and the Insurance A/R 
breakdown with Totals. 

2. For each Guarantor (Family), there will be a total of all of the dependent's Patient A/R, as well as 
the totals of all of the dependent's Insurance A/R. 

3. At the bottom, there will be a total Family Balance which is a total of both the overall Patient A/R 
balance and the overal Insurance A/R balance.
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A/R Carrier Report

Provides both a summary and detailed report (by patient) showing the amount of accounts 
receivable pending with each insurance company (carrier).

A/R Carrier Report Options

1. Group/Provider: Select a specific provider or group by which to run the report. 

2. Breakdown by Provider: If a Group is selected from the drop down and Breakdown by Provider 
is checked, the report will show the group activity, broken down by the individual providers within 
the Group.

3. Show Patient Details: Will provide the specific patient charges that make up each Carrier A/R. If 
you are wanting a summary report of the total A/R for each carrier, leave the box unchecked.

4. Click Ok to run the report.
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Sample Carrier A/R report, for a Group, broken down by Provider (Summary Report)

To Run the above report: 
-Select a specific Group from the Group/Provider dropdown.
-Check Breakdown by Provider.
-Leave Show Patient Details unchecked.

1. Provider/Group: The Group selected for the report.
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2. The Provider Summary within the Group.

3. The Insurance Company (Carrier) A/R.

4. Indicating the total amount of A/R by aging category for claims that are filed as Primary 
claims with the Insurance Company.

5. Summary data for the Provider's total Carrier A/R, being held in Primary claim submissions 
and Secondary claim submissions.

6. Totals for the Provider's Carrier A/R for both Primary and Secondary Claim submissions 
(when both are applicable). 

7. Percentages of the Total Carrier A/R for the Provider, broken down by aging category.



Practice Management 2012 User Manual  - 529

Sample Carrier A/R Report by Group, broken down by Provider and showing Patient Details.

To run the above report, 
-Select a Group from the Group/Provider dropdown.
-Check Breakdown by Provider.
-Check Show Patient Details.

1. Provider/Group: Indicates the Group that was selected for the report.

2. Provider: Information is broken down by Provider, and indicates who the below A/R is 
referencing. (Shown due to Breakdown by Provider being checked.)
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3. Carrier: The Insurance Company Name that the A/R is referencing.

4. Patient: The Patient charge detail that is comprising the total A/R. 

     - File With:  (P for Primary or S for Secondary) Will indicate whether the insurance company 
above was being filed with as Primary or Secondary for the particular procedure code.
       (For Example, the above sample report would indicate that BCBS was filed with as Primary for 
the code 00120 and $90 is 120 days past due.)
     - CPT: the procedure code included in the claim
     - Date of Service: Date of Service for the procedure code
     - Submitted: The date that the procedure was last submitted/filed with insurance.
     - A/R breakdown: by Current (0-30), 31-60 Days, 61-90 Days, 91-120 Days, and Over 120 Days.

5. Total: Provides the Total Carrier A/R for the patient, with the specific Insurance Company listed 
above.
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Sample Carrier A/R report for a Single Provider with No Patient Details (Summary Report)

To Run the above report: 
-Select a specific Provider from the Group/Provider dropdown.
- Leave other checkboxes blank (unchecked).

1. Provider/Group: The Provider selected for the report.
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2. The Insurance Company (Carrier)

3. Indicating the total amount of A/R by aging category for claims that are filed as Primary 
claims with the Insurance Company.

4. Indicating the total amount of A/R by aging category for claims that are files as Secondary 
claims with the Insurance Company. 

5. Summary data for the Provider's total Carrier A/R, being held in Primary claim submissions 
and Secondary claim submissions.

6. Totals for the Provider's Carrier A/R for both Primary and Secondary Claim submissions . 

7. Percentages of the Total Carrier A/R for the Provider, broken down by aging category.
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Sample Carrier A/R report by Provider, with Patient Detail

To run the above report, 
-Select a Provider from the Group/Provider dropdown.
-Leave Breakdown by Provider unchecked.
-Check Show Patient Details.

1. Provider/Group: Indicates the Provider that was selected for the report.
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2. Carrier: The Insurance Company Name that the A/R is referencing.

3. Patient: The Patient charge detail that is comprising the total A/R. 

     - File With:  (P for Primary or S for Secondary) Will indicate whether the insurance company 
above was being filed with as Primary or Secondary for the particular procedure code. (For 
Example, the above sample report would indicate that BCBS was filed with as Primary for the 
code 00120 and $90 is 120 days past due.)
     - CPT: the procedure code included in the claim
     - Date of Service: Date of Service for the procedure code
     - Submitted: The date that the procedure was last submitted/filed with insurance.
     - A/R breakdown: by Current (0-30), 31-60 Days, 61-90 Days, 91-120 Days, and Over 120 Days.

5. Total: Provides the Total Carrier A/R for the patient, with the specific Insurance Company listed 
above.
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End of Day Report   

Report the charges, payments and adjustments entered each day, filterable by User or Provider. 

End of Day Report Options

1. Select the date to view the transactions that took place on that day. 
2. View transaction data by User or Provider.
3. Select from the dropdown whether you want data broken down and displayed by User first and 
then by Provider, or by Provider first, and then by User. Or leave blank to show all.
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End of Day Report Sample

Details shown on End of Day Reporting:

1. Patient Name and date of service.
2. Procedure and Charge for procedure.
3. Personal payments. 
4. Insurance payments.
5. Adjustments on account.
6. Co Pay taken for patient. The gray shaded grid indicates that the co pay was received but not yet 
applied to the patient account and posted to ledger. 
7. Totals by provider.
8. Grand total.
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End of Month Report  

The End of Month report calculates based on the following logic:

The report aging is based on all charges that have been posted (for the provider/group selected), 
and all payments and adjustments that have been posted to those charges, as of the end of the 
month or the current date, which ever occurs first chronologically. Charges, payments, and 
adjustments must be posted or applied in the given month to appear in the MTD area and in the 
given year to appear in the YTD.

1. Select month to report.
2. Select the appropriate year.
3. Filter by Group/Provider. Leave blank to show all, 
4. Select Date of Service to see the aging based on the Date of Service on each charge.
5. Select Posted Date to see the aging based on the Posted Date on each charge.

A/R Calculations (0-30 Days, 61-90 Days, 91-120 Days, Over 120 Days)

The report aging is based on all charges that have been posted (for the provider/group selected), 
and all payments and adjustments that have been posted to those charges, as of the end of the 
month or the current date, which ever occurs first chronologically.
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MTD/YTD Units, Charges, Payments and Adjustments

Charges, payments, and adjustments must be posted or applied in the given month to appear in 
the MTD area and in the given year to appear in the YTD.



Practice Management 2012 User Manual  - 539

End of Year Report 

Report number of procedures, total charges, payments and adjustments by provider/group per 
year.

1. Select year to report
2. Filter by Group/Provider. Leave blank to show all, select individual provider or group
3. Choose to run by date of service or by date posted to ledger
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Example of End of Year report by date of service by Provider

1. Accounts receivable by month
2. Total procedures, charges, payments and adjustments broken down by month
3. Year to date totals  
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Custom Patient Reporting

Generate reports on your patients, based on multiple criteria including demographics, 
appointment/scheduling information, billing/claim data, etc.  Each selection made within any of 
the categories creates an AND statement. This will mean it will only pull up patients that meet ALL 
of the criteria selected, as opposed to only meeting one of the criteria selected.

Default Output Information (in Columns): 
• Account Number
• First Name
• Last Name
• Address
• City
• State
• Zip Code
• Home Phone

Note: If you select multiple criteria for the report, those additional selections will be added as 
columns to the output you receive, to allow you to see the values for each patient row. If you select 
Unique Patients Only, you will only see the above columns listed, without the additional criteria as 
columns.
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Access the Custom Patient Report

1. Click on View menu.
2. Select Reporting.
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Demographic Info

Enter values for any of the demographic fields needing to be searched.  Be aware that each 
selection that is made creates an AND statement. (For instance, if you select a specific gender 
such as female, and select an ethnicity of Hispanic or Latino, the report will pull all females in the 
system that are Hispanic or Latino.) You may enter selections in any of the categories to search 
multiple parameters.
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Scheduling Info

Search on any of the parameters available under Scheduling Info. Select a Facility from the drop 
down before selecting a Provider/Resource and/or a Scheduplate.
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Insurance Policy Info

Select an insurance company from one of the fields available. Enter a policy type to search for any 
insurance policy with a specific type assigned.
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Billing Info - Account Balance Info (Clincial Suite customers only)

Account Balance Info will enable searching patient balances. 



Practice Management 2012 User Manual  - 547

Billing Info - Charges Info (Clincial Suite customers only)

The Charges Info will be searching for any codes, adjustments or visit detail that is entered within 
the Patient Account. The searh of these codes does not search the SMARText within the 
SOAPnote. It is only a search of the billing data that is billed on the patient's ledger.
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Billing Info - Claims Info (Clincial Suite customers only)

Enter any criteria to pull up patients based on their claim detail.
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Selecting Unique Patients Only

If you have entered criteria that generates multiple entries per patient (for example, running a 
search on patients with appointments within a particular date range), there is an option to only 
see the unique list of patients that fit that criteria. To do that, check Unique Patients Only. This 
option allows you to get a true count of the number of different patients that meet the criteria. Note: 
When Unique Patients Only is checked, your report will only show the default columns for the 
report and will not add on the additional search criteria as additional columns.
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The preview of the report will be shown first and will allow you to export the data in multiple 
formats. 
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Reporting Export options

Any of the options listed above will be available for export. Feel free to export the patient 
information to use to merge with other documents, create graphs, spreadsheets, etc. 
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Security Manager/Audit Log
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Security Manager

How to view and monitor user activity. 

SOAPware menu -> Security Manager

Accessing the Security Manager

1. Go to the SOAPware menu. 
2. Select Security Manager. 
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Viewing system activity

The Audit Log is designed to show the specific activity throughout the system and allow it to be 
displayed by Date, User, Location in the system, IP Address, Section in SOAPware, or by Patient. It 
will show the basic activity that was done, and if an item is clicked on, the Audit Details will show 
the specific changes that were made. 

1. Query the specific information that is needed. 
2. A display of the line item activity performed.
3. When a line item is selected, the Audit Details will show the specific activity performed and 
exactly what the changes were. 
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